
  
 
 

DS1 USER MANUAL 
Including 3 step click by click 

getting started guide 
 
 
 
Thanks for purchasing your DS1! We take the utmost care in design and testing and hope you 
are delighted with your DS1. It contains many unique features that will revolutionise tuning on 
each platform we tackle, and we’re thrilled to share it with you. 

 

About Dyno Spectrum Ltd 
We are an innovative, British company that was started by three of us on both sides of the 
Atlantic with over 10000 hours of development into our first product for the Audi 4.0TFSI in the 
S6/S7/S8/RS6/RS7. 
 
We have a combined 50 years of experience in the automotive electronics industry. Our 
calibrations are widely trusted from race winning and record setting McLarens and Porsches to 
long term reliability in less glitzy applications, and many of you have experienced our work 
through other companies. 

Support 
Many of our users simply want to flash their ECU with a quality off the shelf map and we know 
from our benchmarking that we are highly competitive with strong, safe and refined calibrations. 
The DS1 also appeals to the professional tuner with innovations to improve the quality, speed 
and enjoyment of engine calibration. Support can be found in the Facebook groups “Dyno 
Spectrum Tuning: 4.0t Owners Group”  or “Dyno Spectrum DS1 RS3/TTRS” or by emailing us at 
info@dynospectrum.com. If sending problems, please be specific, tell us what you have tried 
and include screenshots that show the entire screen, ideally pasted rather than photographs. 
Please do not message us personally on Facebook messenger as it is very difficult to keep track 
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of the history of something and the person you are messaging may not be the right person to 
deal with your request, or not available whilst developing or on the dyno. We provide support for 
troubleshooting the DS1 around the basics of connecting to WiFi, updating the DS1 and flashing 
the ECU. We provide support for problems with OTS maps. We cannot provide free support to 
teach you to calibrate these engines or cover the advanced topics at the end of this document, 
whether you are an existing tuner or not. Contact us if you need professional training. 
 
Please give us the chance to put things right in the unlikely event of a problem. We care deeply 
about you and your experience with the DS1, and in the vast majority of cases the solutions are 
simple and contained in this document as we have tested thoroughly. Please shout from the 
rooftops if you love your DS1! 

Legal 
Obey your local laws and only use the DS1 as and where permitted by insurance and 
regulations. Never be distracted when driving, make sure any devices in the cabin are secure, 
do not make changes to the ECU whilst driving unless you are on a dyno. Ensure you comply 
with laws regarding use of browsing devices even if the vehicle is stationary. This is a powerful 
product that can require years of experience to use to its full capability. Only adjust what you 
understand, can measure and verify. Always consider the safety of yourself, others, as well as 
your engine, drivetrain, vehicle and the environment. Please be aware that increases in engine 
performance can result in a loss of traction even on dry surfaces with four wheel drive, and that 
tyres, suspension, braking, drivetrain and cooling will be worked harder. Ensure optimum 
maintenance of your vehicle. Dyno Spectrum Ltd accepts no liability for loss or damage to 
people or property or consequential damages. Any vehicle tuning increases risk of component 
failure, and we cannot accept any liability for this, even though we take every precaution to 
enhance safety and have a heavy testing programme. By using our product you agree to 
this. 
 
Our work is Copyright Dyno Spectrum Ltd, protected by encryption and subject to UK law. We 
reserve the right to deploy our considerable countermeasures to detect and prevent piracy. If 
you are skilled enough to hack our product, please make your own innovations instead. 
 
All trademarks are acknowledged of any vehicle manufacturer or other company mentioned. 
Unless explicitly stated, we are not associated with any of them. 
 
We hold the minimal personal data about you to serve you as a customer. If you receive 
communications from us that you don’t want, tell us. 
 
Nearly all regions have emissions laws, and whilst our OTS maps have a reasonable basis for 
not increasing emissions, this may not be the case with custom tuning for which you and/or your 
custom tuner are responsible as with the many other tools that can edit ECU contents. 
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Supported vehicles 
Worldwide support: 
Audi S6, S7, S8, RS6, RS7, A8 4.0T of the C7 and D4 chassis, model years 2012 to 2018. 
Audi RS3, TTRS, RSQ3 with facelift 8V, 8S and 83 chassis, DAZA and DNWA engines, model years 2017 
to 2021 (2023 for RSQ3). 
Audi R8 and Lamborghini Huracan with 4S (facelift) and 4T chassis, 5.2 V10 model years from 2015. 

Getting started 
●​ Plug in the DS1 to the OBD port 
●​ DS1 LED will breathe 

 
You need two apps on your DS1: 
 

 = Factory: updates OBD app 
 

 = OBD: flashes your vehicle 
 
Your DS1 arrives with only the Factory app because we don’t know the software versions on 
your vehicle. 
 
In this three step process you will obtain the OBD app from the Dyno Spectrum servers specific 
to your vehicle. 
 
The three steps of: 

1.​ Connect to DS1 WiFi 
2.​ Connect DS1 to internet 
3.​ Update OBD app 

... should take about 2-3 minutes total with a strong WiFi signal and good internet connection.  
 
After that you don’t need your internet connection again because you can use the DS1 WiFi 
anywhere. 

1. Connect to DS1 WiFi 
On your browsing device, connect to the DS1 WiFi network. The name is the same as the serial 
number on the label of the DS1 (some are blanked out in the photo) and also on or in the box. 
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The unique password is also on the DS1 label, is case sensitive and 8 characters long (3 are 
blanked out in the photo). 
 
Ensure the password label cannot be seen outside the vehicle for your security. 
 
 
Select “Connect automatically” on Windows. On Android, select “Stay connected” if you are 
alerted that there is no internet access. Rarely, on Android you may need to manually disable 
cellular data or use airplane mode to connect to the DS1.  
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You will see an icon like this on Windows with the warning showing that there is no internet 
access. You don’t need to wait if Windows says it is “Checking network requirements”. On some 
Android devices, the following step will not work if they remain connected to cellular data, in 
which case cellular data may need to be disabled manually. 
 
Open your browser (Chrome is the most tested, Internet Explorer does not support modern 
features and is not supported) and type 192.168.4.1 and you will see: 
 

 

shows that you are connected to the Factory app which the DS1 arrives with. Its job is to 

connect to the internet and update the  OBD app for your vehicle. 
(There is no need to be alarmed about the “Not secure” warning in the title bar on some 
browsers. You are connected to a private WPA2 encrypted WiFi network generated by the DS1 
and the reason for the warning is that it is not part of the public internet protected by HTTPS.) 
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2. Connect DS1 to internet 
Click Scan Wifi networks and you will see: 
 

 
 
Then you will see a list of 2.4GHz WiFi networks (if using iOS as a hotspot you will have to 
select "Maximize Compatibility” to run 2.4GHz): 
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The three networks here are shown coloured according to signal strength, green, yellow or red. 
Here, the green access point is 10 feet away, the yellow hotspot from a cell phone is 50 feet 
away, and the red access point is 70 feet away through two brick walls and is too weak to use 
reliably. 
 
Each time the DS1 connects to the network it will use the strongest if there is more than one of 
the same name like here, but once connected, it will not roam to a stronger one unless it has 
disconnected. 
 
If you cannot obtain a green or yellow network, move the car until you can, or consider using a 
mobile hotspot from a phone/tablet/dongle. If you use a hotspot, you will need to also use a 
separate browsing device to the hotspot to connect to the DS1. 
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Click to select your network. Type in the password then click Connect. When you have a 
connection to the internet you will see: 
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Key to information once there is an internet connection: 

 

 

Last update: 24 September 2025 dynospectrum.com 
Copyright (2019-2025) Dyno Spectrum Ltd. Reg in Scotland SC637530 

Reg Office:272 Bath Street, Glasgow, G2 4JR, United Kingdom 
info@dynospectrum.com  

9 

mailto:info@dynospectrum.com


3. Update OBD app 
Click the Update tab: 

 
This DS1 has connected to the internet. The greyed out OBD 0: 0 version info shows it has not 
had an OBD app installed. With the ignition on (dash lit up) you can click Update & restart 
(~1min). If a purchase has been made for your vehicle type and we have support for your ECU 
version, this will consume that purchase for your vehicle and permanently associate this DS1 
with your vehicle. The DS1 is not transferable to another vehicle, and is not refundable whether 
the ECU is flashed back to stock or not. A DS1 can be used with only one vehicle. 
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This is what you’ll see immediately after you click Update & restart(~1min). 
 
Over approx the next minute the DS1 will go through all the following steps: 
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In this case, this DS1 is reaching the end of its update and is about to restart automatically to 

the OBD app so you can flash. 
 
Nearly all problems during updates are due to WiFi and internet connections - see 
“Troubleshooting”. 
 
If you see “Purchase required” please send your DS1 serial number to info@dynospectrum.com 
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Flashing your vehicle 

After it restarted you can see  at the top showing it is in the OBD app. 
 
You need to do a “Full flash..” This typically takes 3-4 minutes involving all our custom code, 
flash counter resets. 
 
What most users will want to do is select Full flash… and then choose an OTS stage. Any 
user/tuner maps will also be shown here and in the File tab. 
 
After Full flash, Cal flash… will appear and is a 30 second flash to change stage or custom tune.  
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Guide to OTS stages 

 
Here is the Help tab at the time of writing. If using an OTS map you need to choose a stage. Or 
you can talk to the custom tuners (click “Find a dealer” on our website) and they can fix you up 
for bespoke options. If you have already established this, please skip to Selecting the stage. 
 
There is quite a bit of detail in this section but most users will choose a stage 1 or 2 from the 
regular sections. The special ones are not directly flashable, available from the File tab only, 
designed for custom tuning and require logging and have safety considerations. 
 
To run flex fuel you also should really use a flex fuel sensor but you can experiment if you have 
measured the ethanol content of your fuel by entering the ethanol content manually from the 
ECU tab. 
 
For all engines, Stage 0 is a stock/base file with flex fuel and map switching enabled, although 
the tune is not populated to actually respond to ethanol content. 
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2.5T 

Regular 

Stage 1 is a stock or mostly stock engine. 
Stage 2 has intakes, intercooler and/or high flow catted downpipes. There are options for 850cc 
or 980cc injectors that allow more boost in dense air above E62. 
Stage 2X aims to reduce boost taper, but can sometimes cause a little overboost on 
gearchanges as the turbine speed can be higher at red line and has to slow. Logging advised. 
 
Downpipes must only be used where the product is certified for use in your location. 
Downpipes that are certified for use will not produce check engine lights or fault codes and do 
not need them to be bypassed. Using downpipes that have inadequate cat performance will 
produce fault codes. We cannot enter into discussions about circumventing emissions 
systems. Where downpipes were previously used, these setups have also been used with OEM 
downpipes and they work well particularly with ethanol, water methanol injection 

Special 

The following examples are not directly flashable, available from the File tab only. Maps with 
(ALPHA) in the name can be downloaded from the File tab, but do not appear in the list to flash 
directly. These setups need logging and benefit from customization for different parts. The boost 
levels are capped by the compressor limit tables only and ready to increase: 
 
Stage 3 (ALPHA) is the same as stage 2 with 980cc injectors but does not taper the boost 
request as engine speed increases. It is designed for upgraded stock frame turbo on a stock or 
built motor. Depending on the turbos and actuators used, KFLDIMX may need to be altered to 
adjust the wastegate response. 
 
Stage 4 (ALPHA) is for a built motor, it has the same boost request as stage 3 to do a first pull 
and then the boost can be increased when everything works. It is based around a built motor, 4 
bar SENT pressure sensors, wastegate solenoid at 30Hz, full frame turbo, Iroz fuel pump, 980cc 
injectors. It is very easy to get 700WHP+ on this setup, assuming you use the same spec and 
everything works you will want to adjust the boost target upwards, adjust KFLDIMX for 
wastegate response and tune the ignition timing to optimize. 
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4.0T 

Regular 

Stage 1 handles tune only. It also is the choice for RS6/RS7/S8 with upgraded intakes. Std 
RPM for stage 1/1 COD on RS6/RS7/S8 for stock TCU have stock rev limits to avoid TCU 
errors. For performance or plus models (with 597HP/605PS), use the ones without “Std RPM” 
in their name as their TCU can handle 7000 RPM. “COD” in the name means Cylinder On 
Demand is preserved. 
 
Stage 2 on S6/S7/A8 is for full intakes to the turbos (SRM or the larger intakes from 
RS6/RS7 fitted to S6/S7). On RS6/RS7/S8, stage 2 used to be for downpipes, but now is for 
cool climate use and/or ethanol ideally, intakes optional. It runs a little more boost. 
 
Downpipes must only be used where the product is certified for use in your location. 
Downpipes that are certified for use will not produce check engine lights or fault codes and do 
not need them to be bypassed. Using downpipes that have inadequate cat performance will 
produce fault codes. We cannot enter into discussions about circumventing emissions 
systems. Where downpipes were previously used, these setups have also been used with OEM 
downpipes and they work well particularly with ethanol, water methanol injection. 
 
Stage 3 is for intakes and one step larger turbos. On S6/S7/A8, one step larger turbos means 
RS6/RS7/S8 turbos. On RS6/RS7/S8, one step larger turbos means approx 4mm larger 
compressors (eg SRM +4mm, Turbo Systems TS1). Using some ethanol or higher octane fuel 
is strongly recommended on the high compression engines (S6/S7/A8) particularly. You 
should also consider TCU upgrades from other vendors (find them in the Facebook group: 
Dyno Spectrum 4.0T owners group or through our dealer page) as there is a risk of clutch slip 
on the S6/S7 and the rev limits being too low particularly on the A8. Datalogging is important at 
stage 3 and above and with ethanol to make sure that knock and fuel pressures are under 
control as well as the boost being optimal. 
 
Stage 4 is for S6/S7/A8 only and is stage 3 plus approx 4mm larger compressors  (eg SRM 
+4mm, Turbo Systems TS1). 
 
Std RPM variant for ZF 8 speed models should be used for regular S8 or RS6/7 models (ie < 
597 HP/605PS stock) that do not have a TCU tune. Performance or Plus models with 597 
HP/605PS stock or with TCU tunes should use the ones that do not have std RPM in their 
name so that the rev limiter is 7000 RPM to match the TCU. Others can change RPM limits as 
per later instructions. 
 
LP lines and HPFP plungers 
If you want to run more than E25 on turbos larger than S6/S7/A8 (includes stock turbos 
on RS6/RS7/S8), you need to upgrade the high pressure fuel pump plungers/pistons to 
1.5mm larger such as made by Autotech or as complete units from Loba. Cleanliness and install 
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technique is vital for these to avoid problems. You also need upgraded low pressure lines. 
Then you can run the stages that have “LP lines and HPFP plungers” in their name and the 
ignition timing, lambda and sometimes boost pressure (especially if your base fuel is 91 octane) 
will increase as you approach E50, whereas without these parts and maps the boost pressure 
will drop rapidly to less than stock as you approach E50. On turbos larger than RS6/RS7/S8 
you will probably not be able to reach full E85 and will have to datalog to determine the level. 
Often our users settle at E50 to E60 on these larger turbos depending on the air temperatures, 
elevation and boost achieved. With custom tuning, further upgrades to the fuel systems are 
possible or recommended and there are new products to address fuelling in development all the 
time. For example, in cold air, or with uprated actuators and pressure sensors, you may not 
reach full E85 and your custom tuner will advise. 

Special 

Stage 3X (RS6/RS7/S8 only) and Stage 4X (S6/S7/A8 only) are examples and not directly 
flashable, available from the File tab only. 
 
These maps have 100% initial WGDC and 3.0 pressure ratio (approx 2 bar or 29 PSI boost at 
sea level) target from 4000 to 7000 RPM so they are on the absolute limit of the stock actuators 
and 3 bar pressure sensors. They provide enhanced acceleration for the initial several seconds 
and for longer only if charge temperatures can be controlled. Many setups will not achieve 
target depending on intakes, absence of leaks, vacuum system condition, altitude. The files are 
available for download from the File tab and can only be flashed by downloading them, 
removing (ALPHA) from the filename and sending them back to the DS1. They are only suitable 
for use with ethanol, race fuel or water methanol injection. They will quickly get high charge 
temperatures unless used with improved cooling or water methanol injection. They may 
overboost beyond target depending on turbos and intakes since they are at the limits of the 
stock 3 bar pressure sensors. Running over 3 bar absolute with 3 bar pressure sensors means 
the ECU will not increase its load calculation and will rely on the lambda sensors and knock 
control to correct fuelling and timing which can have consequences for an overboost situation! 
They will overboost with upgraded actuators for which the WGDC must be reduced. They may 
cause fuel pressures to drop and you may not reach full E85 in cool conditions at sea level with 
them, E50 WITH upgraded LP lines and HPFP pistons is often achievable with upgraded turbos. 
They may cause knock with inadequate octane and cooling. They may damage turbos and 
engine if used improperly and must be logged and their use fully understood. They are 
provided as examples only. Please see the Starting guide for using TunerProRT. We may 
direct users of TS1 or +4mm turbos who have controlled charge temperatures and very little 
knock to use them after logging on the normal OTS maps that target 2.8 pressure ratio on these 
turbos. There is no sensible hope of doing this with 91 or 93 octane. 
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5.2 

Regular 

Stage 1 is for normally aspirated vehicles. It includes pump gas, race gas and flex fuel. On sub 
600 HP models it opens the throttle after 6000 RPM where it would otherwise shut about half 
way. 

Special 

BOOST is an example described in the Project SABRE manual, not directly flashable, 
available from the File tab only and designed for custom tuners using custom boost control code 
and tables based on our example. 

Selecting the stage 
Now we know the stage… in this picture we have chosen stage 1 on an R8: 

 
Most will use Full flash… then an OTS map. If you do not click Yes or No within 10 seconds, the 
question will disappear and the command will be cancelled. Ignition must be on (dash lit up), 
engine off. 2019- 2.5T need the hood open to flash or they will show a “No reply to 31” then 
“Could not complete ECU command”. 
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If there are any active fault codes in the engine ECU, they will be shown and you will be asked 
whether you want to proceed. Fault codes can be downloaded later from the File tab. 

Precautions during flashing 
We’re not the first to put flashing in the hands of users, but amongst the first to do it wirelessly 
with proper robustness on such complex vehicles. However, safety precautions are still 
required. 
 
During the flash you must not unplug the DS1. This would be about the worst thing you could 
do without ensuring the process has finished. You should be able to start again at any point 
though.  
 
The Audi 4.0T stops you turning off the ignition with the button during a flash (we tried so you 
don’t have to). Do not operate current consumers like seat heaters, headlights, radio, seat 
massagers, windows during the flash. Even if the interior fans are off at the start of a flash, they 
will turn on during it, feel free to turn them off. It is brief enough that you don’t need a power 
supply during the flash as long as your battery is decent and charged. 
 
The dash will make all sorts of noises and errors during the flash as the other modules in the car 
cannot see the ECU. Every vehicle does this when the ECU is being flashed. Do not panic, just 
wait until the end and all the faults will be cleared. 
 
The DS1 itself is doing the flashing, your browser is there to keep you informed. If your browser 
loses connection during the flash because your browsing device moved away from the vehicle, 
or you closed the browser window or disconnected from WiFi etc, you can reconnect to the DS1 
whilst the flash is going on and see the status updating. You can also refer to the LED on the 
DS1 - it will be flashing quickly whilst a flash is occurring, and when complete it will breathe. 
 
One important note is that other devices wired into the powertrain CAN bus directly (or 
indirectly by plugging or wiring through the OBD port) will interfere with a flash if they 
use engine ECU diagnostic protocols during an ECU flash. These may include piggyback 
devices (which have no use with a DS1), dataloggers, dongles, aftermarket steering 
wheels with data displays, security devices, radar detectors, remote start modules etc. 
 
If the DS1 LED does not illuminate when plugged in, you may wish to check the fuse for the 
OBD port is not blown. You could plug in other OBD devices and if they are not powered by 
USB, you will likely see whether their LED illuminates in this case or not. 
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Result of Full flash 

 
Each segment is erased then flashed over 3-4 minutes total and the orange text will show a 
counter as each is flashed. On 5.2 the master ECU is flashed first, then the slave so it takes 
twice as long. The number of segments flashed varies from 5 to 8 depending on the ECU and 
the type of flash. At the end it will tell you to turn off the ignition - this is two presses of the 
ignition button so the dash illumination goes off. Hit “Clear fault codes” if prompted, wait a few 
seconds until it completes clearing all other modules of faults, because they got upset about the 
ECU going quiet whilst it was being flashed. On versions after 1645 it will offer you buttons to 
clear and read fault codes for convenience in case you need them. 
 
Then you can start the engine. Every time a 4.0T is flashed, just after engine start there is a 
slight blip in the idle. 
 
Do not worry if you see some extra information early on in the flash mentioning 7F reply written 
in blue. It will clearly say if there is an error and will not say “Flash completed” at the end if 
anything went wrong. 
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Cal(ibration) only flashes are about 25-30 seconds, and follow exactly the same process except 
there is only one segment flashed. They can only be done after an initial full flash. After 
updating the OBD app, we require a full flash again to ensure compatibility, even if the ECU was 
previously fully flashed. 

First few minutes after flash (4.0T and 5.2 only) 
For the first several minutes after flashing the 4.0T ECU runs lambda 1 and does not richen. 
This is important because if you run high boost it could get too hot from being too lean on an 
extended pull immediately after a flash. It is a reason to use realtime tuning if you are making 
regular changes to test them since it is NOT affected. Please wait several minutes (once the oil 
temp is at 70C when started from cold after a flash I never see this, but people have noticed it 
when flashing an already warm engine and then going to do another pull immediately say on the 
dyno or drag strip) or if you have lambda showing on a datalog or dash gauge, when it shows 
some activity richer than 1 you are good to go. 

Choosing map switch after flash 
AFTER YOU HAVE FLASHED, you will be on map switch 0 which is for 91 octane in OTS 
maps. You can see the other choices in the Help tab and map switch 1 is for 93 octane, and 
others are for race fuel and special modes like valet or cooling. Please see the following section 
on map switching with the cruise control buttons. 
 
When using flex fuel, please choose the map switch for the main gasoline that ethanol is 
blended with. So if you have 91 and E85 in some blend, use map 0. If you have 93 and 
E85 in some blend, use map 1. You do NOT want to be on map 3 for 104 octane when 
running E60 and then go and fill with 91 octane for example and forget you have selected 
a race fuel map. There is no advantage to selecting map 2 or 3 when running lots of 
ethanol. We adjust for ethanol content using ethanol content not map switching. 
 
Please refer to separate documents about realtime tuning where you can alter the calibration 
whilst the engine is running eg on the dyno. This means that typically any ECU only needs to 
have one full flash with initial settings and one cal flash to commit the final version.  
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Map switching - how to 
WARNING: Do not be distracted whilst driving by map switching and gauges. These 
features are designed for adjustment and monitoring on a track or dyno. Even then you 
should familiarise yourself with them whilst the vehicle is stationary and not be 
distracted whilst on track. 
 
Map slots from 0 up to a maximum (tuner defined) of 8 inclusive are shown on the rev counter 
as 0 to 8000 RPM. See video in “Gauges on boost display” below. 
 
Please see the Help tab for a list of fuel types and map switches, but map 0 is 91 octane, map 1 
is 93 octane. These are using (RON + MON) / 2, but some regions use RON. Map 0 shows 0 on 
the rev counter, map 1 shows 1000 RPM on the rev counter. 
 
To enter map switching mode, start with the cruise control stalk in the ON position with cruise 
control not active. If you press cancel on the cruise control stalk for 2 seconds, the check engine 
light will flash whilst in map switching mode if the engine is running. Map switching works with 
the ignition on, engine off, but the check engine light will not flash although you will see the rev 
counter move. You can hit up and down on the cruise control stalk to change maps. The change 
is immediate. Be careful to only select a map suitable to the situation you are in and beware of a 
sudden change in acceleration if you are moving and one map has wildly different performance 
to another. Ethanol content is also shown on the cruise control set speed display (whether your 
speedometer units are mph or km/h). You may need to change map slot for the ethanol content 
to display the first time. If you do not press cancel, up or down for 2 seconds, the map switch 
mode is exited. 
 
There is a datalogging monitor to show which map is selected. 

Datalogging 
The highest performance datalogging is performed with DS2. This is included with your DS1 
purchase. Please see the DS2 user manual from the same page where you obtained this 
manual: Getting Started 

Stock flash 
Hit this if you want to flash the ECU back to stock. It takes about 3 minutes. Follow the on 
screen instructions. It is completely stock. 

Manual restart and points to note following updates 

By default the DS1 will start into  if present, or  if not. 
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Update tab, “Manual restart”: you can click  or  icons to restart the DS1 into either of 
these apps (if shown in green under “Versions”, otherwise the restart will be into the other app). 
Sometimes the WiFi connection will be lost during the restart and if you did not select connect 
automatically you might need to reconnect to DS1 WiFi and refresh the browser. 
 

Rarely,  can also be updated from . It takes about 20 seconds, but if you do this as 

directed by support, you will then need to update  from  which takes about a minute. 
 

After updating , only a full flash of the ECU (not a cal only flash) is possible to ensure 
version compatibility. Until the ECU is flashed the first time, the DS1 will not enter power saving 
mode. After verion 1615, the DS1 will still sleep after an update if the ECU has ever been 
flashed before. 

Updating the OBD app later 

When we update the  app or OTS maps, you need to manually restart into  as above 
and then hit Update & Restart as you originally did in section 3 of Getting Started above. If you 

update  from  you will not get the updated OTS maps and it will probably say “No 
update needed”. 

LED 
●​ BREATHING: DS1 is ready, there are no errors and it can be unplugged if you wish. 

 
●​ FLASHING QUICKLY: DS1 is busy - eg updating the factory or OBD app or flashing the 

ECU. Even if you have lost connection through your browser, you should not turn off the 
vehicle or unplug the DS1 if the LED is flashing quickly. If you try to start another 
operation whilst the DS1 is busy, the command will be ignored, or a message will show 
in the browser to tell you the DS1 is busy. During the erase part of updating the factory 
or OBD app, the LED will flash a little slower, but not as slowly as an error. Don’t unplug 
during this time, the browser display will advise. 
 

●​ FLASHING SLOWLY: The last action ended with an error. Another operation can be 
started, the DS1 can be unplugged or vehicle turned off. 

 
●​ OFF: DS1 asleep or not powered. 

 
●​ DIM: If this persists for more than a second or two, the DS1 is not operating normally. 

Please unplug and plug back in the DS1. Contact support if this does not resolve. 
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File manager 

 
Here you can download the stock calibration for use in TunerProRT for normal or realtime 
tuning. The xdf definition is also available to download (not shown here) as a zip which must 
then be unzipped to use with TunerProRT.  
 
You can also upload a modified version of it. The MED17_1_1 or MED17_1_62 prefix and .bin 
extension must be kept, and it must be based on the stock downloaded file, or it will be rejected. 
Do not use commas in file names. When uploading a file, you will probably want to type in a 
description that will be displayed instead of the file name, which may have commas but keep the 
length sensible to fit in the browser. Duplicate filenames uploaded will be renamed to avoid 
erasing. You can click Show/hide filenames to see the filenames as well as the description.  
 
Please see Tuner map encryption in Advanced topics on how to create encrypted .ben files. 
These files cannot be downloaded from the DS1, only uploaded. 
 
Only user files can be deleted. 
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Power saving 
The DS1 will sleep when ALL of the following conditions are met: 

●​ is shown in the ECU tab 
●​ You are no longer connected to the DS1 in the browser, TunerProRT or DS2 datalogging 
●​ ECU and gateway are asleep (there is sometimes a delay before this happens) 

 
The LED will be off completely when the DS1 is sleeping. 
 
Without power saving, the DS1 alone will discharge a full battery in about 100 days. With power 
saving, 8 years. 
 
DS1 should wake up when the ECU does and be ready to use immediately, which can be when 
the driver’s door is opened or the ignition is turned on. You can always unplug and plug in the 
DS1 any time to wake it up. On some platforms, starting the engine will also awaken the DS1 
from sleep. 
 
We are very frequently asked if the DS1 needs to remain plugged in after flashing. Because it 
sleeps you can, but you don’t have to unless you expect ethanol content to be updated from a 
flex fuel sensor, or if you want to use logging, gauges etc. 
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Troubleshooting 

 
 
If the browser has loaded the webpage from the DS1, but the connection is 
inactive, the DS1 icon will be shown in grey and for a while may flash 
green/grey whilst trying to reconnect. 
 

The possible reasons are shown. Only one browser may be connected at once, but more than 
one device may be connected to DS1 WiFi, although we recommend you do not allow this to 
avoid this situation. If you have a phone and a laptop that have both connected to the DS1 
previously, then it is possible that one could stay connected to the DS1 and keep it awake 
without you realising, and then you may try to connect with another device and see this screen. 
This is the most common reason for this, and what you should look at first. It could happen 
when the DS1 restarts and the browsing device connects to another WiFi network, hence the 
advice to click “Connect automatically”. The DS1 and browser will drop their connections with 
each other if they have not heard from each other for 10-20 seconds to try to avoid unused 
sessions locking out new ones. 
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Weak connections 
The DS1 has one physical radio and is a tiny device that connects to two WiFi networks 
simultaneously. This presents difficulties with weak WiFi and/or poor connections to the internet 
when the DS1 is updating as it is writing its flash memory whilst it continues to operate (contrast 
with the ECU which cannot run the engine whilst being flashed). Whilst we have put a lot of 
work into improving the stability and testing with weak connections, sometimes the connection 
to the browser is unavoidably lost during an update whilst the DS1 handles the huge number 
retransmissions that occur with poor connections. If there is still a WiFi connection to the 
internet, the update should complete and you can consult the LED and note when it stops 
flashing and starts breathing to see that the update has completed. You will also see after a 
successful update that the versions in the Update tab will have changed and that the DS1 has 
restarted into the OBD app. If an Update fails you can try again, and it is for this very reason 
that we have a Factory and OBD app so that one of them can always start the DS1. You will 
ensure a smooth experience if you ensure a good WiFi and Internet connection. 
 
Every problem with WiFi connections in the public beta was solved by the user adjusting 
their location relative to the WiFi source, and ensuring that the WiFi source had a good 
connection to the internet. 
 

OTS troubleshooting guide 

Fault codes 
Fault codes are not normal from OTS maps - fix your car, they are all tested on multiple cars 
and do not produce faults. You can always flash the car stock to exclude the tune as a 
cause. Common faults are oxygen sensors/exhaust leaks around them, vacuum and boost 
leaks, faulty charge cooling pumps, misfires from coil packs/old plugs, low and high 
pressure fuel pumps. A good place to seek diagnostic advice is the Facebook group as 
many of them have experienced and fixed the same issues. There are presently no known 
"Since you tuned my car" faults related to the DS1 or OTS tunes that are unresolved or 
present on multiple vehicles. We're not disinterested, but cannot provide the degree of free 
diagnostics services we are sometimes expected to. Often you need a good mechanic. 

Known problems 
No tune can fix known problems with your car. Fix them before tuning. If you are moving 
from another tune, it is common for problems that you think are due to another tune to 
actually be a problem with your car. 
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Custom parts and tunes 
Please ask your custom tuner about your logs from custom tunes. Please ask your custom 
tuner for support with parts that are not supported by OTS tunes. If you have a TCU tune 
from a third party, please contact them with any issues related to rev limits, shifting, 
jerkiness when pulling away - these are not related to the OTS tunes. 

Underboost/overboost/throttle closures 
All cars vary, especially depending on age, leaks, turbo condition. A healthy stage 1 car will 
almost always hit and hold target boost in good conditions. 
 
Some intake configurations and aftermarket turbos need much more WGDC than others, and it 
varies between installations that appear similar. OTS tunes only support stock wastegate 
actuators. Generally we prefer to not have to force the boost up by upgrading the actuators 
especially just to prop up a weak installation that on other cars makes good boost because 
maybe they have fewer leaks or better maintenance. If you are shooting for over 2 bar boost 
and quarter mile records, you want custom tuning, actuators, upgraded pressure sensors and 
correctly sized turbos and supporting parts. 
 
If you are running over 90% WGDC and not reaching target boost in higher gears, there isn’t 
much the tune can do. It can be pushed a little to get it to 100% WGDC more easily and if it is 
reasonably near to target it will learn over time and get near. 
 
If it is far below target and not over 90% WGDC, and is not learning you could be left with 
something below target. The wastegate duty tables can be increased to try to get it nearer, but 
we had to make the OTS maps in a state that doesn’t leave most healthy cars overboosting. 
 
Occasionally a car will overshoot its boost target by more than 0.3 bar in the latest OTS maps 
and if this is the case the throttles will close (but please note that the pressure sensors only read 
to just over 3.0 bar absolute so may not be able to reach this much above target). We have 
carefully chosen boost PID gains to try to get the best response and hold boost on the widest 
range of cars, but sometimes if things are too far out an oscillation or throttle closure may be 
setup.  

Last update: 24 September 2025 dynospectrum.com 
Copyright (2019-2025) Dyno Spectrum Ltd. Reg in Scotland SC637530 

Reg Office:272 Bath Street, Glasgow, G2 4JR, United Kingdom 
info@dynospectrum.com  

29 

mailto:info@dynospectrum.com


Knock 
Knock retard is normal on pump gas. Best power and torque are found where there is 
occasional knock retard such as -0.8, -1.5, -2.3 or -3.0 on scattered cylinders on a mostly 
random basis and the stock tunes on 93 octane do this and on 91 octane are often worse. If you 
have -6 or more negative especially on multiple cylinders, you need to use a lower octane map 
(even if that means using map 0 for 91 octane on 93 octane), or improve your octane (eg by 
ethanol but see notes below), intercooling or add water methanol injection. If the ECU has to do 
a lot of knock retard it is better to go to a lower octane map because your average timing will be 
higher on a tune that occasionally pulls a little timing than on a tune that learns heavy knock 
adaptation over multiple cylinders. Some cars knock more than others and the OTS settings are 
a safe base from which cars can adapt but that do not neuter engines that are more knock 
resistant. Apart from us or the ECU retarding ignition for safety, when we are using sensible air 
fuel ratios and boost levels on the OTS maps, there isn’t anything we can do to make your car 
accelerate faster when it shows knock retard, but changes to the car or fuel can work wonders. 
 
If you are using water methanol injection, >E50 or 100 octane (R+M)/2, especially with high 
boost you really want to be seeing less knock than pump gasoline. 
 
Upgraded turbos on high compression engines (S6/S7/A8) will not see their best results on 91 
octane or even 93 octane, especially with high intake temperatures. You will note that the 
manufacturer lowered the compression ratio on the S8 just to run a boost pressure of 1 bar 
(14.5PSI) on pump gas, whereas some OTS maps target 1.8 bar (26PSI) of boost on a higher 
compression ratio! The high compression engines come alive with better knock suppression 
methods, please use them to avoid disappointment. 

Charge temperatures 
Related to knock and other density altitude discussion, but these cars get really hot. The charge 
cooling is not adequate even for a quarter mile of high boost in warm conditions. They really 
suffer with charge temperatures over 60C and the fastest cars have charge temperatures under 
40C. Apart from running lower boost which it will do as the temperatures get hotter, there’s 
nothing the ECU can do about this. Watching you don’t flatten your battery you can use the 
extra cooling map switch before staging, but the ECU or tune cannot pack more oxygen into 
your cylinders electronically. The intercooler pump duty is already at 95% on OTS maps. 

Dyno testing 
Use dyno mode (remember to turn it off afterwards). If the boost, knock and charge 
temperatures are not good, neither will the results be. Dyno tests without datalogs are pointless 
and hardly worth discussing as everyone is in the dark about the operating conditions of the 
engine. No one knows if the results of the simulation environment of the dyno are equivalent to 
the real world unless you have data from both in logs to compare. If the charge temperatures 
are higher than ideal which is virtually a given on 4.0T for example, there will likely be excessive 
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knock retard which also results in lower boost targets to protect the engine. The higher charge 
temperature will also cause lower boost targets and the less dense air reduces power as well 
because there is lower oxygen mass in the cylinders to combust. A combination of several 
degrees of timing being cut and 30C higher charge temperatures can result in 100-200 HP 
being lost from a measured engine output which is more than the effect of many mods you are 
trying to assess. You end up with an unrepresentative triple whammy of engine protection 
measures not revealing the true engine performance. Even with stellar cooling, it is common to 
get one good pull on a 4.0T and then have to cool it for what seems an age before getting 
another good result. We have not tuned the OTS maps to perform well on dynos but to give 
smooth, safe, strong acceleration as long as the temperatures and knock are coping. 

Fuel pressure 
Healthy fuel systems with stock or upgraded parts to match the OTS specs work well. If your 
fuel pressures are too low or too high, you need to fix the components or installation. There are 
no known issues in any of the OTS maps. 

Performance 
Two cars with the same OTS map, one gets a good time, another does not. The OTS maps on 
well prepared cars in good conditions all have substantial improvements from stock and we are 
happy with their performance. They are not tuned to set quarter mile records, but intended to be 
strong, smooth and reliable in use beyond a quarter mile pull. Sometimes they will do very good 
quarter mile results, but are not set out to break all quarter mile records on the first attempt by a 
random person in poor conditions on a poorly prepared car, which would be impossible and also 
dangerous. The bottom line if your results are worse than another car did on OTS is you need to 
fix or maintain your car or improve your technique. You might have a leak (either boost or the 
vacuum system controlling the actuators), old plugs, old filters, slipping clutch, poor tires, poor 
technique, inadequate octane, poor density altitude or heat soak. You cannot compare a time 
with some or all of these problems with a record breaking time that was done after multiple 
attempts in cold air with all the right parameters, and in some cases you could easily be a whole 
second slower on a quarter mile! There are only so many levers the ECU can operate, and 
unless you can get the correct air and fuel into the engine with a good spark, the tune cannot fix 
it. Finally, if you are performance testing, do a datalog as well. Otherwise you have no clue as to 
the reasons your engine is performing well or badly. 

Wrong parts for the stage selected 
If you fit an OTS map with the wrong parts (such as missing parts of the spec) then poor results 
or damage may occur. You should get a custom tune, or log carefully and adjust the tune 
yourself if you are competent. Particular hot spots are missing fuel system components,or 
upgraded actuators that produce dangerous overboost and absolutely need a custom tune. 
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Wrong map switch 
Please refer to the Help tab in the DS1 for a guide to what fuel is to be used with which map 
switch. A few users have run race fuel maps whilst running pump gas, some after changing from 
race gas and then not putting the map switch back. We cannot underline how dangerous this is. 
The ECU might pull -12 degrees of timing, but it is not something to do to an engine you care 
about. 

Incorrect ethanol mixture 
With RS7 or larger turbos, the highest you can safely run is about E25 and OTS maps will 
reduce boost after this, unless you fit HPFP pistons and LP lines and run the appropriate map. 

Not using an ethanol content sensor 
Entering ethanol content in the browser was designed to be a temporary fix only until people 
can fit a sensor. Some have run completely incorrect ethanol blends and run into dropping fuel 
pressure problems. E85 needs about 50% more fuel and the ECU doesn’t have this adjustment 
range from its lambda sensors. This is why we did flex fuel correctly with a sensor, please use 
one. 
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When to push the boost higher with custom tuning 
Regardless of whether you actually can get more boost from your turbos due to your actuators, 
intake and exhaust restrictions, absence of leaks (on vacuum control or pressure pressure 
sides) and a healthy engine along with trans/clutches that don't slip (and all these assumptions 
are often not covered and make an ass out of you), these are a few considerations to decide 
how hard to push your boost and whether to go to higher WGDC. These and more will be fully 
considered by a good custom tuner, but the following will help you in understanding why you 
cannot boost forever without all the right ingredients: 
 

Thermal management/octane/compression ratio 
 
If you only want to do a quarter mile then you are going to be able to run more boost for a 
shorter time before your temperatures run away from you compared to a 20 minute circuit 
session or a twisty route where you are constantly braking then accelerating, or indeed 
sustained very high speeds. If you start your quarter mile hot, you are not going to get a good 
time. It isn't just density altitude, but knock prevention.  
 
If your temperatures, octane and compression ratio cannot support your chosen boost level the 
ECU will retard ignition timing, add fuel and eventually reduce boost to control knock. There is 
no way around it except to improve the octane and cooling. 
 
You can set higher initial boost levels but be sure to have the "border the max" tables set a cap 
on the engine load as charge temperatures increase. If you set the initial boost level too high, 
your first pull or part pull may be great if you cooled it down enough first, but it won't last. Some 
4.0T on stock cooling can increase charge temperatures by 10C per gear or more, and that isn't 
even pushing the boost that hard. If best performance is had from charge temperatures below 
40C and best safety below 60C then you can see that on a 30C day starting with charge 
temperatures at 50C if you are lucky, you're already in the death spiral for performance. 

Turbo sizing 
 
If your turbos are too small, your pressures in the exhaust manifolds due to turbines or turbine 
housings restrictions will be much higher than your intake pressures. This causes the engine not 
to be able to expel gases as well on the exhaust stroke and can cause reversion during valve 
overlap. You will get high EGTs which can encourage knock which causes ignition retard which 
increases EGTs further... Meanwhile the compressors that are too small are inefficient and blow 
hot air which overwhelms the charge cooling and causes more knock and causes more ignition 
retard making the EGTs hotter still and very soon you get something that at best is hot and slow 
and at worst starts to damage components. Even a 100% efficient compressor used to 
compress the air three times will massively increase the air temperature just from the 
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compression. If you are lucky your compressor efficiency might be 70% and some people push 
the boost hard enough that the compressors are barely 50% efficient and the compressor maps 
are not even drawn out to the points being used, although often we have to guess as 
compressor maps are not always available. 

Cylinder pressure 
 
More torque results from higher average cylinder pressure, but when you are not knocking, you 
can increase the mean cylinder pressure substantially with a much smaller increase in the peak. 
This is one of the few free lunches with turbocharging. However, you can still bend a rod, push 
coolant through the head gaskets, damage rod bearings or pistons without knock. Far more 
often, it is knock which directly damages parts through pressure spikes which can be ten times 
those of normal combustion and are like hitting parts with a sledgehammer, which is why all the 
previous points are so important. Also knock removes the boundary layer of insulating air 
between your pistons and gas temperatures that are higher than the melting point of those 
pistons. If you have all the conditions to keep it knock free, it is then a judgement about how 
much the engine will take and for how long. If you have not addressed causes of knock, the 
knock will usually get you well before this point which is why so many have premature failures. 

Summary 
 
Read your datalogs, look at the "Temp charge air" and "Knock #x" where x is each cylinder. A 
proxy for exhaust manifold pressure is WGDC, if you need to rapidly increase WGDC to 
maintain boost, the exhaust manifold pressure is blowing open your wastegates. If you gain 
power and torque for each increase in boost and can maintain it with good ignition timing and 
temperatures in the range you need for as long as you want to run you are good. Most 4.0T are 
not at this stage and that is why most of them are not truly fast yet. 
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Advanced topics 
They are not needed to flash an off the shelf map, so if that is all you want, you don’t have to 
read further. 
 
The DS1 is powerful and has a multitude of other features, some of which are demanding even 
for experienced tuners, but we open them to any capable DS1 user to lift the veil from the 
secretive world of Euro engine tuning and convert a closed platform into one of the most tuner 
friendly on the market. Please realise that we cannot provide free support for these topics. 
Contact us if you need professional training. 
 

Changing OTS rev limits to match TCU tune 

Changing pressure sensors 

Changing intakes 

Changing actuators 
 
https://docs.google.com/document/d/1BvAO1WF04tJF4INqpTndcY6QHpd9K8b1_8GZS2TOf30 

Wastegate rattle (2.5T only) 
With aftermarket downpipes, the wastegate may rattle. OTS tunes do not fix this. The vacuum 
operated wastegate is normally open and the throttle is opened instead for improved efficiency. 
On emissions controlled vehicles we can’t worsen the efficiency and therefore emissions in 
parts of the map that are used most of the time and therefore part of drive cycle emissions 
testing. Please consult a custom tuner and adhere to your local emissions laws. 

Pops bangs flames 
OTS tunes do not directly change factory pops and bangsif they are present, but they may be 
reduced due to changes in EGT thresholds. On emissions controlled vehicles with catalyst(s), 
our tuning cannot safely or legally enhance pops or bangs or add flames because the fuel being 
combusted in the exhaust instead of the cylinders increases emissions and/or damage the 
exhaust(s) and catalyst(s) from heat and pressure and has resulted in engine and/or vehicle 
damage including fire. Please consult a custom tuner and adhere to your local noise and 
emissions laws.  
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Dyno mode (4.0T only) 
Activate this on the dyno. It makes for a much smoother dyno experience. Beware that the MMI 
screen will retract. Vehicle stability may be impaired. Do not drive the vehicle off the dyno whilst 
in dyno mode. 
 
Be sure to turn off dyno mode and clear codes after finishing the dyno session. 
 
If you do not turn off Dyno Mode and clear codes the MMI will not work. You will need to turn off 
Dyno mode and clear codes in order for it to come back.  
 

Boost gauge wrap (4.0T only) 
If you have enabled “Lap timer” in VCDS or other coding packages, the normal boost gauge 
range is 1-2 bar absolute. We triple the the range so that vacuum is shown (0-1 bar absolute), 
and high boost (2-3 bar absolute). It should be fairly obvious from the driving situation and 
datalogs which range the boost gauge is in.  
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Gauges on boost display (4.0T)/virtual cockpit power and torque (2.5T/5.2) 
https://youtu.be/3VA45kYTOwQ Please see this video how to select gauges. It is the same as 
map switching except you start with the cruise control stalk in the OFF position and within 2 
seconds of switching to ON, hold CANCEL for 2 seconds. The EPC light will flash whilst in 
gauge select mode on 4.0T and the CEL will be solid for 2.5T. 
 
We have 7 pre-defined gauges for 4.0T: 
0=boost(0-3bar absolute with each screen showing a 1 bar range) 
1=air temp(0-100C) 
2=low fuel pres(0-10bar) 
3=high fuel pres(0-200bar) 
4=lambda(0.75-1.0 lambda) 
5=knock(0-10deg) 
6=ethanol(0-100%) 
 
https://youtu.be/u1OR6i8pjVE This shows the 6 gauge types, although in this video we were 
using map switching to select them, so now the EPC light will flash instead of the check engine 
light when selecting. Additionally we have added ethanol because vehicles with active cruise 
control do not display cruise control set speed in the cluster. 
 
On RS3/TTRS/R8/Huracan: 

 
When switching gauges the CEL is shown solid (whereas when you map switch the CEL 
flashes). 
 

Adjustable launch control (DAZA only) 
When the vehicle is not moving, you can rev the engine to where you want the launch control 
RPM to be and hit SET on the cruise control stalk. We recommend not revving the engine whilst 
in park, but to do so in neutral. 
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Flex fuel sensor 
The Continental flex fuel sensor signal line needs a 3Kohm (+-10%) pull up resistor to 12V. 
Signal line is connected to pin 15 of the back of the OBD port. Only this single wire needs to 
cross the firewall. (Please note that other devices connected to pin 15 such as dataloggers, 
diagnostic tools, adjustable exhaust flap devices will interfere with the flex fuel sensor readings. 
Pin 15 is not commonly used by anything modern, but some other devices do things on this pin 
to support older legacy protocols.) 
 
Silly Rabbit Motorsport sell a kit. There are also discussions re DIY options on Facebook 4.0T 
performance or Dyno Spectrum groups, or Audizine. 
 
The flex fuel sensor needs fused and ignition switched 12V and ground connections. Wire 
routing should avoid excessive heat, snagging on moving parts and electrical noise. We do not 
sell a kit and would refer you to other vendors. You do not need and indeed cannot use flex fuel 
converter boxes that convert the signal to a voltage, just connect to the sensor itself. 
 
On some vehicles, pin 15 (L line) is a legacy serial interface which is no longer used by modern 
tools, so if there is already a wire there it needs to be disconnected and insulated. 
 
The DS1 detects out of range due to sensor faults, excessive water contamination, high 
frequency noise due to poor wiring or electrical interference. DS1 only sends what it interprets 
as valid readings to the ECU. “CAN ethanol error timer” is set in the ECU by default to 0 which 
disables it to avoid a check engine light with stage 0 map for those not using an ethanol content 
sensor, but we suggest 20000ms, so after this 20s without a valid reading, a check engine light 
will illuminate and the ECU will continue to use the last known (presumably good) ethanol 
content transmitted by the DS1, and this is remembered when the engine is turned off to give 
good starting performance. This remains the case even if the DS1 is unplugged from the OBD 
port. If CAN ethanol error timer expires the map switch will also change to map 0 as a failsafe. 
Some have used this as a failsafe with water methanol injection kit errors with a flex fuel sensor. 
 
For testing purposes, you can alter the ethanol content manually in the DS1 browser. This will 
only be useful if no valid readings are being sent from a connected ethanol content sensor 
because otherwise the setting will not persist, so if you want to lock a different ethanol content 
(eg for calibration), you’ll need to unplug the sensor. 
 
There are datalogging monitors that show the ethanol content and the blending of fuel, ignition 
and load. 
 
Ethanol content and any errors are shown in the browser. 
 
We have tested wildly different ethanol/petrol/gasoline refuelling events and seen fuel trims 
remain within +-2% which is as good as stock.  
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Realtime tuning and datalogging 
Please refer to separate guides on using TunerProRT and DS2 which are PC based apps that 
use the DS1 directly without the browser and allow calibration of any value or table in the ECU 
whilst the engine is running whilst also datalogging at 100Hz with up to hundreds of channels of 
any variable in the ECU. The browser can be open and used at the same time, but there are 
some interlocks to prevent conflicts: 

●​ Any command clicked from the ECU tab will stop the DS2 datalogging 
●​ Whilst the DS2 is datalogging, the DS1 will not reconnect to the internet if its connection 

has been lost 
You can refer to our datalogging guide for the DS2 that is found in the “Getting Started” section 
on the Dyno Spectrum website.  

Connecting to DS1 via router instead of DS1 WiFi 

 
These options have been thoroughly tested including for updates and ECU flashes, but can be 
complex for users who do not understand networking and for whom just connecting to the two 
WiFi networks to update once for their vehicle is enough hassle, and so are not officially 
supported. If you are reading this and know why you need it, it might be for you and no doubt 
some advanced users will think of interesting uses and are welcome to discuss in our forum. 
 
For the DS1 browser, you can connect to the DS1 by connecting your browsing device to the 
same router/hotspot that the DS1 uses for internet access and using the orange IP address. 
The blue and orange IP addresses are also clickable, but you need to change WiFi networks 
manually to make each one work as they are on different WiFi networks. This is useful if you are 
keeping the vehicle in close range to the router and can be used in the same building to update 
the DS1 or flash the ECU remotely, as long as you consider the safety aspects. With a VPN, the 
DS1 browser could be connected to from anywhere in the world, but we have not tested this. 
You could also use this method if you wanted to use the vehicle’s WiFi hotspot (with a SIM card) 
or a mobile WiFi dongle or a hotspot from your phone. This allows the browsing device to 
remain connected to the internet. For DS2 you can use eg DS2 --ip=192.168.1.33 (example, 
yours will be different) and TunerProRT you can do this in preferences and reconnect: 
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The DS1 also transmits the ds1 name on the network to which it is connected, but the usage of 
this varies depending on the OS of your browsing device: 
 
Using OpenWRT router: http://ds1 or http://ds1.lan 
Windows (with Bonjour), Linux, Apple: http://ds1.local 
Android: BonjourBrowser (Play store), click ds1 
 
Windows with Bonjour can be slow to connect, but the other options were fast in our testing. 
They are a convenient method to discover or replace the IP address entered in the browser that 
is allocated by DHCP by your router. 
 
If in any doubt, use the DS1’s WiFi and 192.168.4.1 in your browsers. You also have the option 
of using a nano or similar small USB WiFi dongle (802.11n 150Mbps is sufficient) to connect to 
the DS1, and then you can use your device’s internal WiFi to remain connected to the internet.
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Custom inputs 
●​ 32 channels of EGT, ADC or switch inputs can now be logged in DS2. The CAN inputs 

must be attached to powertrain CAN (500kbps, 11 bit frames). 
●​ CAN ID 0x780-787: eg https://www.ecumaster.com/products/egt-to-can/, 8 frames, 4 * 16 

bit items little endian = channel 0 to 31 
●​ CAN ID 0x740-747: eg https://www.ecumaster.com/products/can-switch-board/ (with 

change from 640 to 740 or 744 CAN base ID in their lightweight CAN config software 
using eg Kvaser/Peak/ECU Master CAN to USB), 8 frames, 4 * 16 bit items big endian = 
channel 0 to 31, overlaid as alternative to 780 to 787 

●​ Configuration of CAN devices will often be required to set the bus speed to 500kbps and 
the frame layout. The details of this are beyond the scope of this manual. 

●​ MPC1 https://controls.is/mpc1.html can also be used but we do not have ready to run 
examples and the configuration of it isn’t well documented, although their support is 
good. 

●​ Also see Project SABRE manual https://www.dynospectrum.com/getting-started for info 
on how to use these inputs with custom maps and also a new feature on putting outputs 
onto powertrain CAN. 
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Tuner map encryption 

 
You can also see MapEncrypt.zip. Hit Download: 
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Unzip (you will have to give Windows 10 SmartScreen permission to unzip and run the exe) and 
you should see something like: 

 
 
Run MapEncrypt.exe. Feel free to move the folder where you like or create a shortcut to 
MapEncrypt.exe. ProcessCalibration is not useful on its own but needs to be kept in the folder 
with MapEncrypt.exe. 
 
MapEncrypt enables tuners to generate compressed and encrypted .ben files which cannot be 
downloaded, viewed or altered by anyone, even you or us. They are confidential between the 
tuner and the DS1, and use RSA 2048 bit encryption and a randomly generated key by your 
computer. The tool does not communicate with our servers, is self contained on your computer 
and doesn’t need or use internet access. 
 
Below is a completed example.  
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The details on the screenshot show the requirements, particularly we would draw your attention 
to the comments in red. This is a one way process and its only purpose is confidential transport 
of your work to a user, you cannot store your work this way and edit it again. 
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When the .ben file is sent to the DS1 through its File tab, the description used is the one that 
was entered in the Encryption tool. Prefix must be MED17_1_1 for our initial supported ECU, 
and extension must be .ben 
 
When the file is sent to the DS1, it takes about 2-3 seconds to process and will report success 
or error. It is suggested you test the process on your own DS1 before sending files to users so 
you can support them in the use of your confidential and valued work. 
 
Below is the result in the file tab after uploading and you can see “Go even faster” near the top. 
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This can be flashed in the usual way from the ECU tab, either Full flash… or Cal flash…
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Change log 

21 September 2025 
1655 
5.2 new version support: 
4S0907552CC_0001 (requires bench unlock) 

22 October 2024 
1655 
Add lookup of VAG codes 
Fix timezone in timestamp of browser logs 

1 March 2024 
1654 
5.2 new version support: 
4T0907552AE_0002 (does not require bench unlock) 
4S0907552BS_0002 (requires bench unlock) 
4T0907552BA_0001 (requires bench unlock) 
4T0907552BC_0002 (requires bench unlock) 
4T0907552BE_0001 (requires bench unlock) 
4T0907552BG_0001 (requires bench unlock) 

18 June 2023 
1654 
“Tester present” is stopped after an action ends in an error (eg reading knock tables with hood 
not opened in last 20km on a 2019- car). This avoids a situation where the vehicle is kept awake 
which could discharge the battery. There is no need to flash if on the latest version - it is just an 
update to the DS1 itself. 

27 April 2023 
1652 
5.2 new version support: 
4S0907552CA_0002 (requires bench unlock) 

14 April 2023 
1652 
5.2 new version support: 
4T0907552BD_0003 (requires bench unlock) 
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22 January 2023 
1652 
4.0T add MfVD folder to xdf for high pressure fuel pump control 
 

15 September 2022 
1652 
5.2 new version support: 
4S0907552BF_0001 (requires bench unlock) 
4S0907552AL_0001 (does not require bench unlock) 
 

4 August 2022 
1651 
Full flash recommended for all vehicles after this update. 
 
Fix 2.5T DS2.exe (download/use new version from File tab) and Gauges in browser/bTres so 
they can start log without opening hood/bonnet in the last 20km on 2019- models. 
Fix 4.0T occasional small blip in idle speed after warm restart (requires flash). Thanks to 
Ricardo Semexant for exhaustive testing. 
Fix handling of filenames with non ASCII characters eg Cyrillic. 
 
Add 4.0T MAP sensor voltage levels to xdf for custom tunes on aftermarket MAP sensors. 
Add 5.2 support for 4S0907552BN_0001 and 4T0907552___0006. 
Add realtime axis editing in browser. 
Add “deleteall” to manual commands to erase all user files without prompt (usually calibration 
files and saved DTCs). Refresh the browser afterwards to see the updated File tab. 
 

 
New DS2 on 2.5T is now a separate version to 4.0T to work with the hood/bonnet closed on 
2019 models. It will say 2.5T and v1650 when started. 

12 April 2022 
1649 
24HY PCV recall for 2019-2021 2.5T DAZA only 
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Custom tunes must be updated by your tuner, but the same content can be used as none of the 
code has been changed, only the calibration is part of the recall. 
The updated files will be supplied by the server if your ECU has been updated as part of the 
24HY recall for PCV diagnostics. If you wish to or need to get your ECU updated, stock flash 
first, get it updated at the dealer, then update the DS1 and flash again. 
Updated files are: 
8V0907404J__0004 
8V0907404L__0002 (updates from 8V0907404K__0001) 
8S0907404J__0004 
8S0907404K__0003 
8S0907404M__0002 
J__0004 also include the ignition timing fix from the factory that we put in version 1640 on 11 
June 2021 as a critical update (the J__0002 files had a mistake from the factory). 

22 March 2022 
1648 
Add Realtime tab to browser. Needs permission enabled in setting tab once. 
Please verify normal engine operation and file changes before using in anger. Otherwise it 
works like TunerProRT with limitations: no editing of axes or hexadecimal tables yet. 
Please refer to the notes in version 1647 below if this update has been skipped. 

1 March 2022 
1647 
All vehicles: this update requires a full flash after updating for logging to work. This is 
because there are many optimisations to logging. If you use DS2 or TunerProRT dll, there are 
also new versions required and these will be shown as 1647 when opened. There is a 
reminder about this after updating referring to these instructions. 
 
There are many new features for all ECUs and user interface improvements. See the end of the 
change log for 5.2 which has a lot that is new. 
 
TCU torque limit now sets to 2000Nm instead of 1000Nm. This has no effect on normal driving 
but will be useful for custom tuners to enable them to design systems that request torque over 
1000Nm instead of compressing the load-torque relationship above 800Nm. Add items to xdf to 
allow 2000Nm CAN rescaling on 4.0T and 5.2. These were already in 2.5T, but appear to have 
potential to go to 1500Nm (previously increased from 500Nm to 1000Nm in 2.5T OTS). 
 
DS2.exe shows progress when sending monitors to ECU. 
 
Add Data tab that shows DS2 data in a table. Collapse settings tab into submenus. 
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Add ability to change SSID in Settings. If you forget your password there are 3 reset methods 
with OBD Y cable where using another device will reset the DS1 SSID and password to default: 
1. Using another DS1. Settings... Reset DS1 SSID & password to defaults on label 
2. Generic OBD fault code reader Clear codes 3 times 7DF 01 04 
3. CAN tool sending 6FF 'r' 'e' 's' (0x72 0x65 0x73) with DLC 3 
 
Allow DS1 to reconnect to a bTres that is powered by a switched 12V that cuts immediately 
 
Add ability for user to upload .html, .js, .css, .mp3, .gif, .png, .svg, .jpg in the file tab, note the 
space is 2MB (with which you can do a huge amount if you avoid large libraries and media and 
focus on functionality) and is shared with compressed custom calibrations. .html, .js and .css are 
clickable shown in green in the file tab and will run in a User tab that will open: if they are all the 
same name then clicking either the .html, .js or .css will open them all. If .gz is in the name it 
must be a gzipped file. We will document the plain CAN, UDS and realtime tuning comms 
possible through this tab with small example files showing some buttons that perform simple 
tasks. The idea is that users can make their own panel to interact with the ECU, particularly 
making realtime adjustments with a button click or slider, as well as working with custom code in 
the ECU and interacting with other modules. There is a realtime permissions setting that must 
be enabled after reading the disclaimer to allow the browser to make realtime changes to the 
ECU. We are working with a developer on a realtime tuning module for the browser. 
 
[ADVANCED]Project SABRE/Compiler 
Add callers running at sync, 1, 2, 5, 10, 20, 50, 100, 200, 1000ms. You do not need to worry 
about the return value from these, they are just triggers. There is also a new caller at 200 in the 
list that receives frames on IDs 7x0 to 7x7 where x is 0,2,6,A,C,E and the ID is not: 700, 703, 
740-747, 780-787, 7E0, 7E2, or 4 byte frames on 7E3 (V10) or 7E5 (2.5T and 4.0T). 
 
Compiler additions: 
refuelled (1 in engine run cycle after the tank has fuel added until the key off) 
ethanol (read only where E0 = 0, E100 = 1000) 
writeethanol(a) (function to write with value a where E0 = 0, E100 = 1000) 
cansend(uint16_t id, uint8_t data[8]) (function to write 11 bit CAN frames with 16 item queue) 

5.2 V10 
Add missing intake and exhaust cam timing tables to xdf on early Huracans (4T0907552A and 
C). 
 
Add “NOT REALTIME” warning to the ~1% of V10 xdf items that cannot be realtime tuned 
(MoF/MoX), like the other platforms. 
 
Add dyno mode 
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Add cold start enrichment tables to flex fuel. To retain compatibility with previous calibrations, if 
the tables are left empty, the parent (stock) tables are used. 
 
Ignition timing/ in xdf: “(UNUSED)” ignition tables marked. After flashing the ECU using this 
1647 update (custom or OTS), the ignition tables that were interpolated towards when intake or 
exhaust cam timing are away from target (eg IgCtl_ag tables without “Out” in the name or 
KFZW) are not used because the interpolation is turned off for both intake and exhaust cam 
timing errors. Now the main ignition tables for gasoline and ethanol in the map switches are 
used when the injection mode is 4, and there are just two tables in the IgCtl folder that are for 
GDI or PFI only that should be made safe (ie retarded to suit turbos) in case the ECU uses an 
unexpected ignjection mode. The rest are marked “(UNUSED)”. Please see V10 main ignition 

timing ZWGRU in: 

https://docs.google.com/document/d/1Ya2AsNuBFW83Pl2RubSxBgHjJHtzc96Evye1FYjqxWs 
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17 January 2022 
1646 
[ADVANCED]Project SABRE/Compiler - all engines/versions - (flash needed for these to work) 
New callers: 
redsol to randomly cut individual cylinders. We have tested on the V8 - if you set it to 8 it cuts all 
the cylinders, 0 cuts none. This could be useful for holding back engine speed for limiters where 
ignition retard generates too much heat. 
PthSet_trqInrCtOff for the torque for individual cylinder fuel cut calcs, we haven’t used this as 
we did it with redsol but this might be smoother for eg traction control applications as it looks like 
it will combine ignition and fuel cut. 
tvldste_w for WGDC output on 4.0T (5.2 doesn’t have this and KFLDRL does similar on 2.5T) 
Compiler: More variables, more RAM, access to custommapheader as “this”, better error 
reporting. See help when loading the compiler. 
 
V10 boost controller example in Project SABRE doc: 
https://docs.google.com/document/d/1uSyY_nouhmPvHleehblTeQVW44fDED93XeiQXA5oS4k/
#heading=h.izwy6sd65vns 
This is open for the tuner to customise. xdf, bin, logging are all available for all 31 V10 versions. 
There are other examples recently added to the same document. 
 
Add missing torque monitor tables and target high fuel pressure tables to “MY14” V10 
4T0907552A and C xdfs 
 
Add ability in Settings to change DS1 default WiFi password from what is shown on the label. 
We recommend you do not change it as human passwords are able to be cracked by dictionary 
attacks easier than random 8 characters used by default. Because of this, if you must change it, 
you must use 12 to 63 characters from A-Z a-z 0-9 and at least one of each of these three 
groups are required. No symbols are allowed. When the password is changed it will be 
confirmed and shown once, never to be seen again. There is no recovery possible if you forget 
your new password unless you are able to find the DS1 on your WiFi network through its IP 
address to get back into the browser. If you lock yourself out we’ll need to charge you a 
replacement cost for a new DS1.  

24 December 2021 
1645 

2.5T 
Add support for RSQ3 DAZA 83A907404A 
Fix virtual cockpit gauge scaling on 8S0907404L 
OTS: Raise boost in colder temperatures on stock injectors (stage 1 & 2) on gasoline 
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xdf: Flex fuel/map switch enable has a new option 4 used on above stock injector OTS to allow 
compression limit tables (KFVNTUXS used as boost target tables) use ethanol % to ignition 
blend instead of ethanol % to load blend for better control of the competing needs of extra 
octane vs flow limited fuel systems. 

2.5T and 4.0T 
Ability to request over 4200 hPa boost on custom tunes. This has been tested on built DAZA 
and allows unheard of boost levels on a stock ECU, it should go all the way up to 5120hPa 
without throttle or torque interventions. 

4.0T 
Add an injection table to xdf (thanks Kyle LeBlanc, SRM) 
Improvements to DS1 wake up on engine restart. 

5.2 
OTS maps added with map switch 0 for 91-93 octane, map switch 1 for 104 octane, map switch 
2 for cooling fans. All have flex fuel with fully scaled direct and port injectors, ignition and fuelling 
adjustments. Rev limiters raised 200RPM. 
[ADVANCED] Option for choosing whether project SABRE custom maps run on master, slave or 
both ECUs without having to lookup the address of the master/slave flag per version. Boost 
control example in map switch 2 - see Example at end of Project SABRE manual. This takes a 
MAP sensor input on CAN and outputs a WGDC on CAN. 

All versions 
Every version has its ECU code changed, but unless you are using the advanced features 
or something specific listed above, you do not need to reflash if you were already on 
version 1641 or higher. DS2 and TunerPro from 1641 still work. 
 
DS2 logging now in DS1 so that when you go to the gauges tab, when you save a log it will be a 
full DS2 log (on iOS it will need renaming to .csv as it changes the name when downloading a 
file). DS2 still remains as an option using the Dyno Spectrum viewer. bTres users will need to 
update bTres, do this after updating DS1. Thanks to Travis of BetterThan who make bTres for 
his work on getting the gauges working again once this large change was introduced. 
 
User interface of OBD app improved: now starts in ECU tab and by default shows only a few 
basic options to flash (click More to see the rest). Clearing codes is offered as a button to click 
at the end of the flash. Cal flash only shows in the default list if it is possible. The most useful 
tabs are now at the left. DTCs now combined for OBD and VAG, master and slave ECUs. File 
tab now contains monitors.csv. 
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Added ability to read cal from ECU, if security allows. If it cannot be read, you will get a 7F reply 
and “download empty”. This takes 2-3 mins. If you want a DS1 calibration, download it from the 
File tab. 
 
[ADVANCED] If you send a custom monitors.csv to the DS1 you can use that by entering and 
saving its filename (without /spiflash/) in the settings tab and also set the mask away from the 
default of 3. This does not include dbc content. 
See Project SABRE manual - changes to how CAN frames are sent, ability to insert own code. 

11 November 2021 
1643-g45401bb84 

2.5T only 
Add support for 8S0907404L__0001 (MY22 TTRS DNWA). 

10 November 2021 
1643-g45401bb84 

5.2 only - END OF BETA 
These are tiny changes just to the xdf. There is no need to flash the ECU after updating the DS1 
and you only need to update if you want the extra tables in the xdf. 

●​ Fix gauges tab in browser, map switching page, where if map switch was 0, the red circle 
would not previously show until the map was changed from 0 and back to 0 again. 

●​ XDF - add more AccPed tables (they convert pedal to torque request), add MAF scaling 
tables which were not shown because they have a read only axis. 

●​ We are working on flex fuel and turbo examples.  

4 September 2021 
1643-g45401bb84 

2.5T only 
Add support for 8S0907404F__0005 (DAZA). 
Fix xdf for all versions where items were outside folders in 1642. 

24 August 2021 
1642-g707159125 
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5.2 V10 
Supports all known worldwide Huracan and 2015- R8 (Gen 2) with MED17.1.1 except one 
2020 model of Huracan with 4T0907552AH software which is locked. 
 
Beta release - includes stage 0 with full throttle opening on the limited 
RWD/RWS/base/quattro/sub 600 HP models, this alone can give up to 80 HP gains and makes 
a sustained urge and different engine note/experience over 6000 RPM that is exciting like the 
performance/plus models. Even on our test 2020 570 HP R8 which has the least gains, it has 
noticeable improvements over 6000 RPM. On stage 0, the timing, rev limits etc are not altered. 
 
Includes all DS1 features, further OTS to follow for flex fuel and example support material for 
custom tuners. 
 
Flashing is as other models with initial full flash, the master will be flashed first, then the slave. 
First flash takes 2 * 3 ½ minutes, subsequent cal flashes 2 * 30 seconds. 
 
Differences between Huracan/R8 and between V10 and other DS1: 
 

●​ Huracans do not support the full range of features using cruise control and tacho even if 
they have cruise control because they do not have a separate SET and CANCEL 
position, but rolling boost on map 9 should work in custom tunes if they have cruise 
control buttons. Ethanol and map switching can be done in eg your phone from the 
browser. 

●​ R8 like the 2.5T models with virtual cockpit will by default show ethanol % and MAP (in 
0.1 bar / % scaling, estimated from MAF sensors) on the power and torque gauges. 

●​ Gauges in the browser presently only show the master ECU. DS2 logging and realtime 
tuning work on master and slave simultaneously. The checksums when realtime tuning 
are shown for master and slave ECUs and the correct advice is given on screen. 

●​ Unlike 2.5T and 4.0T, the map switch and ethanol content are reset to zero with a flash. 
Set them as you wish after each flash. 

 
Whilst we heavily test, during the beta it is recommended that you flash the vehicle for the first 
time in a safe location (eg garage or workshop) and not just before a race when it is the 
weekend or out of hours, and ideally with bench flashing tools available (even better if you have 
backed up the flash and EEPROM of both ECUs first but our rate of needing to bench recover 
ECUs is 0.1%). All tuning is the responsibility of the custom tuner. Every feature should be 
carefully logged to verify things are working before increasing boost on turbo cars. 
 
Pricing on V10 is set at twice the level of 4.0T and 2.5T as this is a niche product with a depth of 
features that has required intensive development that has allowed the OEM ECUs to cover 
nearly all the features of standalones with all the benefits of the OEM quality electronics, driving 
smoothness, diagnostics and super fast installation. Pricing is not discounted during the beta - 
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previous beta users have enjoyed early access and full updates as the features of the product 
have grown and we have more exciting things to do on V10. 
 
DS1 that have not already been used on another car can be upgraded by users or dealers for 
payment of the same as their usual DS1 rate again including any dealer discounts. Email to 
info@dynospectrum.com with the DS1 serial number, we will check it has not been used and we 
will arrange for you to pay. Then we can upgrade a previous unused unit the same working day 
during office hours. 

4.0T 
Fix sleep when DS1 logging enabled (no flash required if updating from 1641). 

2.5T 
OTS - Fix left foot braking. Fix DNWA stage 2 and higher OPF regeneration (thanks to Lukas 
Naumann). Fix RSQ3 xdf address of KFDPVDPU. 
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15 July 2021 
1641-g999ed3467 
 
All: 

●​ Fix non ASCII chars in DTC database. 
●​ More advice shown after update and when uploading custom file. 
●​ Add ignition dwell and minimum LPFP duty to custom maps (see Caller table - scroll 

down to item 100). Thanks to SRM for the requests. 
●​ DS1 logging is now DISABLED by default (see note on next page *) 
●​ All vehicles should be full flashed after the update, and new versions of DS2 and 

TunerPro dll (if used) should be downloaded from the DS1. DS2.exe for 2.5T and 4.0T is 
now different. 

●​ Fill NaN Values with Last must be checked/selected once in the Dyno Spectrum 
Data Acquisition viewer for new DS2 logs to display correctly. This is due to a change 
where we only populate data when it is new to reduce file sizes of logs and fit more in. It 
doesn’t affect the log, just the display of it. 
WRONG: 

 
 
RIGHT: 
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2.5T: 
●​ Double CAN bus torque limit in OTS maps. This is most useful for custom tunes and has 

reduced clutch slip with some TCUs with no downsides. This (despite different values 
entered) ends up with the same scaling as 4.0T and 5.2 in the way the CAN bus is 
configured. 

 
Note re DS1 logging being disabled by default: 
(*) Users were unlocking their car with the DS1 plugged in which would after a short delay then 
start logging automatically, then unplugging the DS1 and other OBD devices would not always 
communicate until the vehicle was powered down and went to sleep. DS1 log toggle can be 
clicked in the Settings tab if you want it back on by default. 
 
 
[OPTIONAL] Developer/tech content follows, do not be alarmed! These features provide 
data 10 times faster and 100 times wider than any other logger we know of. In time these 
features could enter mainstream after testing and refinement, particularly of the applications that 
receive all the data. The ECU side of this is rock solid, the DS1 is solid handling all the data as 
long as the consumers of it keep up, the application side is the fledgling part to consume all this 
data and make it accessible/presentable, but for DS2 it is a case of refining monitors.csv and for 
RealDash improving the xml. 
 
Advanced developer features accessible from Settings tab "Manual command": 
"help" (without the "") will show the following defaults: 
 
Toggle options/status: 
ds2extras 0 
browserextras 0 
realdashextras 0 
allcan 0 
dictionary enabled 
flash 0/4 
 
The first four items can be enabled by entering the name eg "browserextras" (without the "") to 
toggle the setting, a message will show the status when the correct command is entered. All but 
"dictionary" are remembered by the DS1 after power down. 
 
These are settings I’m using presently: 

Last update: 24 September 2025 dynospectrum.com 
Copyright (2019-2025) Dyno Spectrum Ltd. Reg in Scotland SC637530 

Reg Office:272 Bath Street, Glasgow, G2 4JR, United Kingdom 
info@dynospectrum.com  

58 

mailto:info@dynospectrum.com


 
 
allcan lets the DS1 access all the data on the powertrain CAN bus and is generally used 
together with the other options if you want the DS1 to send extra data to DS2, browser/bTres, 
RealDash. 
 
ds2extras in conjunction with allcan transmits powertrain CAN bus data along with the usual 
DS2 data to DS2.exe on a PC, excluding unnecessary diagnostic traffic from 0x700 to 0x7FF 
(but including custom CAN input frames 0x740-0x747 and 0x780-0x787). 
 
These new items can be displayed by editing the DBC based BO_ and SG_ items at the end of 
a custom monitors.csv. 4.0T DBC to append to monitors.csv For 2.5T there is an MQB DBC 
here with marked lines. 
 
The local copy of monitors.csv (in the same directory as DS2.exe) is passed in the DS2 
command line with the option --csv_in=monitors.csv . The DBC section must follow the 
normal DS2 monitors and have a line “DBC” (without the “”) preceding it. Only BO_ and SG_ 
items are allowed. Only @1+ types are allowed. Multiplexes are allowed and used - see 
example file. DBC file education is available on the internet and is not expounded here. The 
exact formatting with spaces must be followed and there is minimal error checking in DS2.exe 
for this. 
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Thanks to Nikita Lesnikov for the DL501 development CAN frame info - the TCU can be put into 
this mode on 4.0T for either DL501 or ZF 8 speed using VAG CAN Pro or VCDS. It may be 
possible for DQ500 on 2.5T to be put into this mode also. 
 
On 4.0T the DBC file info is complete, but whilst the ZF 8 speed development frames are 
included, they are shown in the DS2 log as raw bytes. It is likely that the SG_ entries will benefit 
from some manual renaming (retaining _ instead of spaces as the DBC standard uses spaces 
to delimit fields) and choosing a curated list that people find useful including the ECU (MO_), 
TCU (GE_) and ESP (ESP_) frames for example. Unless the number of items is filtered, in 
testing, the DS2 log viewer is unable to keep up with live display, although the csv file generated 
by DS2.exe copes fine, it does take a while to load it after the fact if there are say 2000 
columns. Using SG_ filtering in the DS2 command line such as filters=MO_ filters=GE_ 
filters=ESP_ and filters=GEZF8_ or filters=GEDL501_ for the TCU development 
frames will help. The ds2extras + allcan data are shown preceded by a ~ in the DS2 logs so 
they appear at the end. 
 
Example DS2 command line whilst in a command window in the DS2 directory with DS2.exe 
and monitors.csv: 
 
ds2 --csv_in=monitors.csv --filter=MO_ --filter=GE_ --filter=GEZF8_ --verbose 
 
The --verbose option shows useful information about which CAN frames are present that are 
not in the dbc, and which are in the dbc that are not on the CAN bus to allow curation of logging 
layouts. 
 
browserextras in conjunction with allcan does similar to DS2 above. In testing so far, on a fast 
Windows laptop, iPhone 12 and bTres will consume frames quickly enough that there are no 
retransmits or problems, but so far the browser code doesn't do anything with the received data. 
These transmit extra CAN frames to the browser as websockets in the form of 4 bytes of CAN 
ID followed by up to 8 bytes of payload. The 4 bytes of CAN ID are big endian and the first byte 
has the highest two bits set, so C0 00 03 30 01 02 03 04 05 06 07 08 shows an 11 bit CAN 
frame with ID 0x330 and 8 bytes of data. If the frame is 29 bit, then bit 29 will also be set so the 
first nibble of the first byte will be E or F. DS2 logging items are not presently sent, but there 
could still be more than several thousand items of data per second. 
 
realdashextras in conjunction with allcan does similar and sends the CAN frames over the TCP 
connection. On a fast Windows laptop or iPhone 12 the CAN monitor will not crash. A 4 year old 
Android with a Snapdragon 835 struggles to show the CAN monitor without stuttering even with 
just the ECU and gateway frames which is about half the traffic in a vehicle with allcan enabled. 
DS2 logging items are not presently sent so the bandwidth is about half of DS2, but still about 
16-18 times what it was previously. This means with the correct RealDash xml, all the browser 
logs that can already be shown, along with CAN bus chatter from all the other modules on 
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PTCAN and if enabled the TCU development frames to show clutch pressures etc should be 
available. This could easily include custom CAN inputs on ID 0x740-747 and 0x780-787 eg for 
EGT probes, pressure and speed sensors etc. 
 

 
Click the driver’s window… 
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Click the instrument cluster… 

 
Click the WIFI/LAN 192.168.4.1:9996… then click the CAN monitor: 
 

 
 
dictionary is a setting to show DTCs without using the dictionary so they are just show as eg 
P0123 without a description. This is just for testing and has little use. 
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flash 0/4 is a DS1 counter to show how many OTS and custom flashes (full or cal only) have 
occurred, in this case, 0 and 4 respectively. It is read only when typing help 
 

11 June 2021 
1640-gb9058743c 
CRITICAL OBD app update for only 8V0907404J__0002 and 8S0907404J__0002 RS3 and 
TTRS (DAZA, mostly 2019). 
 
The manufacturer original files for only these J versions have an error in the calibration of one of 
48 similar ignition timing tables. This erroneous table is used when the exhaust cam control is 
not operational. 
 
The fix for OTS users is to update and flash the ECU. 
 
The fix for custom tunes is to copy the affected table from the new OTS maps (or from any other 
unaffected stock version) and flash the ECU. 
 
The fix should be applied immediately for custom tuners who are actively tuning these versions. 
 
The only change is to the calibration of “Ignition GDI std valve lift” (IgCtl_agGDIBasc_GM). 
 
Background: 
The situation where exhaust cam control is not operational would be expected to be rare and 
show faults and  limp home. The error is that the ignition timing table used in this situation is 
around 40 degrees too advanced at 240% load or higher. Between 220% and 240% load, the 
ignition timing will interpolate and advance rapidly. Below 220% load, ignition timing will be 
normal. 
 
It transpires that after a flash, usually for less than a minute, the intake and exhaust cam 
positions are fixed and during this period this erroneous ignition table is accessed. No visual 
indication on the dash is apparent to the driver that the cam timing is fixed. It is not unusual after 
a flash on many ECUs for various systems to take some time to come on line. This could be 
seen in a live DS2 log where intake and exhaust cam timing would move from fixed positions. 
The problem is not the cam timing being fixed, but accessing a far too advanced ignition timing 
table that is used when the cam timing is in this state. In all other versions the ignition timing 
table is safe, and there is no need to change it from stock. 
 
Screenshot shows the difference between the J stock affected table on the right of the top map 
and the lower map shows how it looks in all the other versions: 
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31 May 2021 
1639-g34685844e 
OBD app update 
Only need to flash if skipping a previous update or for DNWA stage 2. 
 
ALL: 
The gauges in the browser now allow phones and tablets to go to sleep by default. The option 
can be changed by hitting the cog icon in the Gauge tab (highlighted in yellow below) then 
enabling “Disable Device Sleep”. This is useful for users who use their phones for audio 
because the “no sleep” library we use to keep them awake whilst displaying gauges can reduce 
the volume. Thanks to Travis Logan, please have a look at his product bTres: 
https://betterthan.shop/ 
 
DNWA OTS: 
Raise PSRMX to 3100hPa instead of 2900hPa to avoid requested boost dropping if there is a 
slight overboost. 
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Fix some OPF regeneration situations on stage 2 and 3. 
Add dzwvs patch as DAZA (see 1638 update). 
 

 
 

18 May 2021 
1638-ge42423ef0 
OBD app update 
FULL FLASH REQUIRED after update or ethanol content will not update 
 
4.0T & 2.5T: 
Fix info when sending .ben file list to browser for non ASCII characters. 
Add check in ECU to prevent VCDS inadvertently changing ethanol content through CAN. 
 
2.5T: 
Add RSQ3 83A0907404B support (DNWA) 
 
Add KFLDIAVSMX (WGDC low valve lift) to xdf for 2020 K and M and DNWA and copy 
KFLDIMX to KFLDIAVSMX in same version OTS. This should improve boost control at part 
throttle with low valve lift. 
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Add Com_trqMaxNorm_C to xdf and increase in all OTS to 1000Nm. Only really useful for 
high torque custom maps based on stage 4, but added to all stages to be consistent with 
other torque rescaling to 1000Nm. 
 
Add GDI PFI coord folder to xdf (particularly for CoEOM_idxInjModDemSel_CA with entries of 4 
which turns off PFI and can be changed to 0 to prevent this). The output of this can be seen in a 
DS2 log as CoEOM_idxInjModDemAsgn. 
 
Update immo off switch so that engine can be started in chassis swaps like 4.0T. Previously the 
immo off switch was just to allow OBD flashing on 2.5T. 
 
Add oil level, oil pressure, throttle as % (in addition to existing raw) to DS2. 
 
DAZA only: 
Add K_LOAD_DZ load threshold above which dzwvs is forced to 0, but only when it is actually 
being calculated. This prevents retarded timing during launch due to valve lift transition. It is only 
used if not 0. dzwvs is also a new custom map caller but only used if K_LOAD_DZ is 0. 
 
Add GEVlv_PhaGovr to xdf for changing closed loop gains of intake and exhaust valve timing 
 

19 April 2021 
1637-gc649a3b7f 
All vehicles 
OBD app update - improvements to datalogging 
Adds info to first line of datalogs (internal, DS1 and DS2, not browser logs) so you and/or your 
tuner can see useful info about the DS1 and ECU. To use this feature with DS2 where it will be 
particularly useful for custom tuners and their customers, you need to download/unzip/use the 
new DS2.zip from the File tab after updating. 

 
Fix ECU code so that internal log does not get garbage appended when the DS1 is plugged in 
and then starts its logging. This requires a flash. 
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12 April 2021 
1636-g95f430117 
2.5T only - no need to flash unless skipping over any previous updates that required one. 
Delay start of automatic DS1 logging to prevent relocking car triggering alarm on a few vehicles. 
Add KFLDRL for low valve lift to xdf for (2020-) K and M DAZA. 

9 April 2021 
1635-gf7e8adf52 
2.5T OTS updates 
DAZA: 
Add 850cc injector maps (stage 2 and 2X) 
DNWA: 
Fix P064F on RSQ3 
No changes to RS3/TTRS DNWA 

8 April 2021 
1634-g551fb882c 
Update of factory & OBD apps with fixes, new stage 2X 980cc for 2.5T and Realdash updates. 
 
From the OBD app, update the factory app first. Then update the OBD app from the factory 
app. Then reflash required if updating OTS or if skipping over any previous updates that 
required one. 
 

●​ If you go to the old factory app first and try to update you will see: 

 
The DS1 and server will stop you making a mistake. 
 

After the updates, your Update tab will show this if you click “Check latest version”: 

 
 
Factory app: 
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“Check latest version” button updated to handle longer version tags. 
 
OBD app: 
DAZA & DNWA OTS: 
Add stage 2X 980cc with less boost taper above 5000 RPM and extra PFI to compensate. 
These can add power without increasing peak torque, useful for generously specified vehicles 
(eg high flow catted downpipe AND intercooler) with ethanol or high octane fuel. 
Fix occasional P2635 on some versions. 
 
DNWA: 
Stage 2/3 regen fix OTS. 
Add KFLDRL for low valve lift to xdf. 
 
ALL: 
Realdash TCP server increase items from 8 to 24 and fix start/stop command. 

31 March 2021 
1633-g97d3cd77 
OBD app update 
 
Improvements and new features most relevant to custom tuners. 
ECU must be flashed after update. 
 
4.0T: 
Add Com_trqGbxIntv to custom maps. 
 
DAZA/DNWA: 
Insert KFLDIMX and KFLDRL to Caller table, this will move some items down from 1632. 
Add DS2 trans.bat and more torque values from TCU 
 
DNWA OTS: 
Stage 1 and 2 increased load limit on map switches 2 and 3. Stage 2 980cc unaffected. 
 
DNWA RSQ3: 
Fix scaling for virtual cockpit gauges (eg ethanol and boost) 

19 March 2021 
1632-gcf65fca5 
OBD app update 
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1631 was released 17 March then withdrawn to fix a bug in CAN ethanol error time/CEL 
affecting one car. No other 1631 users need to update as 1632 is identical. 
 
Improvements and new features most relevant to custom tuners. 
ECU must be flashed after update or DS1 and browser logging/gauges will not work correctly. 
New DS2.zip should be downloaded, unzipped and used so that DS2 logging can work with 
custom maps sending CAN frames. 
 
All: 
Scroll question into view when browser asks a question 
Add advice to user on attempting to use incompatible files 
 
Browser log/gauges and cluster show ethanol content from custom CAN inputs 
 
Custom maps - pre-release, disabled by default, expert use only with bench ECU 
backup/restore facilities and test as result only initially. Documentation not yet done. 
 
4.0T: 
Extend max pressure sensors gradient from 1024 to 1360hPa/V in xdf to accommodate newer 
MAP sensors. See xdf notes on DSSGRAD and DSVDGRAD. 
 
DAZA: 
8V/S 404J OTS cold start improvements 
8V/S 404K add precontrol WGDC maps to xdf 
 
DNWA: 
Add RSQ3 83A907404___0003 support, please discuss testing methods with Dyno Spectrum 
until dealers have tested 
 
DAZA & DNWA: 
New TunerProRT dll for MED17.1.62 gives more accurate free RAM in title bar - useful when 
developing custom maps. 
 
Thanks to testers Darin of Double D, Frank of Mabotech, Kyle of Silly Rabbit. 

3 Feb 2021 
1630-gdc861094 
 

●​ OBD app update for all cars 
●​ No need to flash if coming from 1629 
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Strongly recommended for RS3/TTRS users who have updated to 1629 as it fixes a bug which 
may prevent sleep. 
 
Adds button in Settings tab to disable/enable DS1 automatic logging when engine running. This 
may be useful if plugging in other OBD devices through a splitter with DS1 as it will prevent 
potentially conflicting traffic. 

1 Feb 2021 
1629-g8d89f507 
 

●​ OBD app update for all cars 
●​ Full flash after updating required 

All DAZA OTS 
Nuisance P2635 fixed 

2021 TTRS DAZA support 
North America region 8S0907404M__0001 added. This appears very similar to 
8S0907404K__0001. If anyone wants their 8V0907404M__0001 2021 RS3 DAZA (North 
America region) done please contact us. 

DNWA OTS 
Load limit raised on stage 2 and table used added to xdf, cold start enrichment on ethanol 
There is a discrepancy of the scaling of 980cc injectors on many DAZA examples and one 
DNWA - logs requested and drive gently if using 980cc on DNWA 

DS2 new items 
Adds fuel tank level, fuel use since start and wheel slip 
 
In the ECU tab there are three new items and history is now shown by default: 
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Read ECU info 

 

Read knock tables 
Shows knock learning view (average of all cylinders on 4.0T, all five cylinders on 2.5T, dynamic 
knock learning on both) 

Read internal log 
If the DS1 is NOT plugged in, depending on version, anywhere from 20 to 60 seconds of pedal 
> 80% is saved in the ECU and until the ECU is powered down after a drive it can be 
downloaded from the ECU tab. It is not wiped when downloaded. If there is no response when 
clicking it, there is no log. 
https://www.youtube.com/watch?v=e9g5kaj1cnY 

Read DS1 log 
If the DS1 IS plugged in, the last 30 minutes of engine run time regardless of pedal is saved 
in the DS1. The log is lost when the vehicle and then the DS1 goes to sleep after the engine 
is turned off. Downloading the log from the DS1 also erases it from the DS1 so you don’t 
accumulate a lengthening log and save it multiple times. 
https://www.youtube.com/watch?v=zgCdS4tbneU  

Manual ethanol set with pedal and tacho when engine off 
Tacho will move after a deliberate small dead zone on the pedal from 500 to 8000 RPM, if SET 
is pressed this will be stored as ethanol content (5-80%, if you push all the way 82% although 
the tacho may stop at 8000). This is immediately replaced by an ethanol content sensor or 
ethanol manual set in the browser. Values less than E5 will not be stored to prevent accidental 
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setting of content: you have to move the pedal AND press SET. Please confirm expected results 
in ethanol gauge or log just like you would with ethanol manual set in the browser. If you need to 
set outside the E5 to E82 range, use the browser or an actual ethanol content sensor. E82 is 
fine as setting even if your E85 measures E85 or higher. 
https://www.youtube.com/watch?v=DPL4_h5cnls 

One for the custom tuners 
Custom tunes no longer need the calibration checksum to be updated when we update the ECU 
code like we have in this update. Instead the first 48 bytes of any custom file (.bin or .ben) sent 
to the DS1 and the software version tag in the file (eg 4H0907557___0010 or 
8V0907404G__0005) are checked to ensure they match the DS1. 
 
Previous .bin files can be used with the new update, but they should be deleted from the File tab 
and then reloaded from your browser after the update. This will convert them to the new 
checksum arrangements and should not need to be done for future updates. 
 
A new mapencrypt.zip is supplied in the file tab that no longer checks the calibration checksum 
either, but this new version will need to be used to make a bin into a ben after the update. This 
will not only be more robust, but save time and allow us to alter the code more freely in 
installments towards custom maps. 
 

12 January 2021 
1628-g6d2c89d5 - only for 8S0907404K DAZA, 8V and 8S0907404H DNWA 
 

●​ Add 2020 TTRS DAZA (8S0907404K) support 
 

●​ Update 8V/S0907404H__0003 DNWA 980cc OTS maps (stage 2 980cc, stage 3 
ALPHA and stage 4 ALPHA) to zero a PFI blend table that was producing a glitch where 
PFI was being used at part throttle below the minimum injector time. After the update, a 
full flash is needed. If you aren’t using 980cc injectors on an OTS DNWA, no need to 
update. DAZA is unaffected. 

 
(After updating to 1628, because this update only involves a few ECU versions, if you click 
“Check latest version” in the Update tab, it will say updated OBD firmware 1627 is available but 
if you attempt to “update” from 1628 it will not actually do so.) 

6 January 2021 
1627-g476086fd 
Optional OBD app update for all vehicles (go to factory app & update the OBD app) 
No need to flash after updating. 
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OTS and custom tunes are unaffected. 
 
Browser gauges/graphing/logging reduced CPU usage for stability and rendering performance. 
DS2 compatibility improvements for some PCs (need to download/unzip/use new DS2.zip from 
File tab to achieve this). 
Add DTC values to DS2 logs so that the point where a DTC was triggered can be seen. 
 
DAZA/DNWA: 
VAG DTC dictionary now covers every code in the ECU with a short name. 
Add more low pressure fuel pump diagnostics to xdf. 

27 December 2020 
1626-g51535e38 
Factory and OBD app updates for all vehicles. The time required by the DS1 to do all this is 
about 7 minutes: 
1. Using the OBD app, update the factory app. 
2. In the factory app update the OBD app. 
3. Full flash the ECU 
Custom tunes do not need to be edited because of this update, but a Full flash of ECU is still 
advised after the update to achieve the last fix below. 
 
Upgraded Factory app makes extra checks of OBD app file system. 
Add battery voltage to DS2. Thanks to Frank Mabo of Mabotech for the request. 
Fix DS2 starting logging on some PCs (download DS2.zip from the File tab in the DS1 browser, 
unzip it and use it). 
Fix compatibility issue with some generic OBD II scanners where they would refuse to connect 
due to a recent change to default always on browser logging. Now the browser will start the 
logging when it needs. This changes DS1 sleep on 4.0T only: it now awakens when the ECU 
turns on or the engine is cranking and uses a previous method to go to sleep which takes 
30-60s after the ECU is powered down. 2.5T sleep/wake is unchanged. 

21 December 2020 
1625-g604aebae 

●​ OBD app update for DAZA - Full flash of ECU after updating advised 
●​ DNWA support for 2019- RS3 and TTRS worldwide versions 

 
DAZA custom tunes do not need to be updated unless a previous update that required this was 
skipped, but flashing is still required after updating to achieve the fix below. 
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Fix map switching/blending of “Limit of max tgt air filling dep on the intake man temp” 
(KFRLXTSRN) and “Cold start factors” (KFKSTT and KFKSTTHDR). Previously these were still 
using the parent tables. 
 
Implications for OTS: Cold start at low temperatures will use the intended extra enrichment and 
high ethanol concentrations on stock injectors will have a load limit that comes in at low air 
temperatures to keep the high fuel pressure up. 
 
Implications for custom tunes: Could cause a change in target engine load depending on how 
your tuner set it up. On the majority of DAZA tunes the original 300% load limit was used which 
was out of the way anyway, so it is most relevant for high boost tunes with upgraded pressure 
sensors and turbos. 
 
DNWA has all DAZA features except it does not include a stage 4 (ALPHA) example as we 
haven’t tested with a built engine. We are happy to provide a DAZA xdf and stage 4 (ALPHA) 
example to DNWA tuners on request and offer support. The main difference is using analog 
instead of SENT upgraded pressure sensors. 
 
Thanks to Mattias Stertman of Stertman Motorsport and Vency of Madness Motorsport for 
testing DNWA stage 1 and 2. These guys are leaders and experts in tuning Audis and great to 
work with. 

15 December 2020 
1624-g6b4c70e7 
OBD app update for DAZA & 4.0T. 
Full flash of ECU after updating advised. 
Custom tunes do not need to be updated unless a previous update that required this was 
skipped. 
 
4.0T & DAZA (these changes do not require a flash): 
Add cylinder roughness monitors to DS2 ECU extras. Experimental but may allow early 
diagnosis of direct injector problems as it does with similar injectors on Porsches. 
Fix DS2.exe exit so that gauges work again and cluster doesn’t enter map switch display for 2 
seconds. 
Updates to browser gauges including display of DA (Density Altitude) and bug fixes. 
Fix low temperature rejection of valid ethanol content that was affecting a few users at cold start 
in cold conditions which would briefly delay the ethanol content coming on line. 
 
DAZA only (these fixes will only occur after flashing the ECU): 
Fix PFI table blending that was causing parent PFI table to be used instead of the expected 
tables during brief period of homogenous split for a few seconds after cold start. 
Fix DAZA air temp gauge on virtual cockpit where a scaling was wrong. 
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22 November 2020 
1623-gede8abf4 
OBD app update for DAZA & 4.0T. End of beta for DAZA. Thanks to all testers. 
 

●​ If you are already on 1621 or higher, go to the Factory app then update the OBD app. 
Then Full flash of ECU. If you are pre 1621, see Tip below. 

 
●​ If you use a custom tune and you previously updated it when upgrading to 1620 or 

1621, you do not need to update it again, but you do need to Full flash of ECU after 
updating for everything including logging and sleep to work. 

 
Tip: You can always click “Check latest version” in the Update tab to see what is available. If a 
new Factory app is available, you can update this first by using the OBD app… Update tab… 
Update. Then use the new Factory app to update the OBD app. Here is a video describing the 
two apps in the DS1 
 
Tip: If you have not updated your custom tune on DAZA, this end of beta is a good time to do 
so. We only require updating of custom tunes for major feature updates. 
 
Tip: The DS1 makes lots of checks to prevent the user doing the wrong thing during an update 
or flash. 
 
Thanks especially for testing and suggestions to: 
Jared Van Leuven of VLM Spec 
Mattias Stertman of Stertman Motorsport 
 
DAZA & 4.0T: 
Fix gear oil temp on Gauges screens in browser 
Improvements to Gauges user interface (nav buttons and start/stop for log) 
Improvements to DS1 sleep and wake logic (be sure to do a Full flash of ECU after updating so 
everything works) 
Ethanol sensor no longer wakes DS1 due to spurious wakeups on some vehicles 
 
DAZA: 
Fix to air temperature virtual cockpit gauge at low temperatures 
 
DAZA OTS: 
Revert exhaust flap changes to stock 
Wastegate duty and proportional gain alterations to improve boost control 
Raised a few rev limiters to 7500 
Raised a torque limiter to 1000Nm to match the rest 
Raised PFI share on gasoline to keep up high fuel pressure in cold conditions 
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Reduced low fuel pressure in low demand areas 

7 November 2020 
1622-gf2f52f39 
OBD app only (go to the factory app and update the OBD app) 
Fix iOS browser compatibility and speed up page load on PC 
No need to flash the ECU or update any tunes after updating if already on 1621. 
Updating from before version 1621 to 1622 requires a flash of the ECU for ethanol content and 
gauges to work. Please also read 1621: 

5 November 2020 
1621-gfd6a1392 
Factory and OBD app updates for DAZA & 4.0T. The actual time required by the DS1 to do all 
this is about 7 minutes: 
1. Using the OBD app, update the factory app. 
2. In the factory app update the OBD app. 
3. From the new OBD app, download and unzip DS2.zip as you need this update for the 
logging. 
4. Full flash the ECU. See note at end about custom tune checksum for DAZA. 
 
4.0T only: 

●​ Starting DS2 logging will now correctly stop the browser gauges and logs. 
 
4.0T & DAZA: 

●​ Option to prevent sending ethanol content to ECU. This is useful for tuning and testing, 
and also to prevent a situation where using VCDS with a splitter and DS1 might send an 
ethanol content like signal on pin 15 which could unintentionally change ethanol content. 
We recommend if not using an ethanol content sensor and using ethanol manual set that 
this setting is used to ensure that nothing can possibly change the ethanol you set. We 
always recommend using an ethanol content sensor with ethanol anyway. 

 
4.0T had the rest of these updates below already so there is no need to update custom tunes or 
read further. 
 
DAZA only: 
GAUGES/LOGS/DTC: 

●​ 2020 8V0907404K RS3: Power and torque gauge scaling fixed when used for eg 
ethanol content/boost. 

●​ Fixed average knock gauge scaling on virtual cockpit gauge set 3, browser gauge, 
browser log and DS2. Individual cylinder knocks in DS2 logs were always correct. 

●​ Browser/gauge log scaling for HPF increased to 32MPa. 
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●​ Browser logs now have many extra items to make them more useful, 24 instead of 8 
items are sent from the ECU at 50Hz. Items include things like g forces, gear oil 
temperature, boost target, ignition timing, injector times and more. DS2 logs are still 
preferred for tuning, but the browser logs are now much more useful. 

●​ Special thanks to Travis Logan: Overhaul graph screen, new gauge screens. Gauge 
screens can be navigated with the arrows (if using a touchscreen) or with a double tap of 
CANCEL followed by UP or DOWN cruise control buttons. Please look out for updates 
on Travis’s beautiful touch screen display with special dash mounting for DAZA and 4.0T 
that will have even more options such as automatic logging to the cloud and support his 
work. 

●​ DS2 now shows a variable name after the English name that matches axes in 
TunerProRT. If using our template to view a standard set to save you selecting them, this 
will be updated soon, otherwise just select the fields you want to display. 

●​ DS2 can now log around 400 items simultaneously at up to 200Hz. Future updates will 
use more of this power and flexibility. 

●​ DAZA now has lambda target in DS2 logs in addition to existing lambda for component 
protection. 

●​ DAZA has option to set default gauge set on Power and Torque gauges. Default is 
Ethanol and Boost. 

●​ Add VAG specific fault code short description. 
●​ TunerProRT can now do realtime tuning whilst the browser gauges and logs work. 
●​ 2019/2020 DAZA now do not have to open hood to commence DS2 logging or do 

emulation. 
●​ Download and use the new dll from the File tab if you use realtime tuning. 

 
CUSTOM INPUTS: 

●​ 32 channels of EGT, ADC or switch inputs can now be logged in DS2. The CAN inputs 
must be attached to powertrain CAN. This has been tested by sending CAN frames with 
Kvaser CAN but designed to be as generic as possible to accept other tools below: 

●​ CAN ID 0x780-787: eg https://www.ecumaster.com/products/egt-to-can/, 8 frames, 4 * 16 
bit items little endian = channel 0 to 31 

●​ CAN ID 0x740-747: eg https://www.ecumaster.com/products/can-switch-board/ (with 
change from 640 to 740 or 744 CAN base ID in their lightweight CAN config software 
using eg Kvaser/Peak/ECU Master CAN to USB), 8 frames, 4 * 16 bit items big endian = 
channel 0 to 31, overlaid as alternative to 780 to 787 

●​ Testing will soon commence with https://controls.is/shop/ecu/MPC1 
●​ Future updates will allow these to be used for control as well as logged. 

 
XDF: 

●​ Many new tables in DAZA xdf. 
●​ TunerProRT now shows the variable names used for the axes to match DS2 logs. 
●​ Add Cal checksum to Flex Fuel/Map switching folder to allow easy update of custom 

tunes when DS1 ECU custom feature code has been updated as long as any new tables 
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are populated. See tooltip in the xdf for details. You can load the map you want to 
modify, then load a freshly downloaded stock as a compare bin, then open Cal 
checksum, click copy and save: 

 
OTHER: 

●​ US model remote door unlock range restored. 
 
DAZA OTS: 

●​ 2019 8V/S0907404J RS3/TTRS: After start enrichment fixed on ethanol. 
●​ Increase in performance. 
●​ Improved wastegate control with a direct WGDC that retains closed loop control but now 

has a clear relationship between KFLDIMX and values in browser or DS2 logs and is 
much easier to calibrate. 

●​ Lambda targets now track target tables more closely. 
●​ Altered PFI blend to give headroom on port injectors in cold weather. 
●​ Increased ECU rev limits to 7500 RPM for maximum TCU compatibility. 
●​ Torque limits and structures smoothly rescaled throughout to 1000Nm instead of 700Nm 

preserving load to torque relationship for TCU and other module compatibility. 
●​ More aggressive load and ignition blend curves for ethanol so that maximum boost and 

ignition will be reached at E50. 
●​ Exhaust flap failure/removal will no longer limit boost. 
●​ Addition of stage 2 with 980cc injectors, compared to stage 2 without 980cc injectors this 

allows a little extra boost from 4500RPM upwards in cool conditions on >E62. 
●​ Optimisation of stage 1 and 2 on >E62 where the load is limited to stay within the limits 

of the stock high pressure fuel pump especially in cold weather. Highest boost is 
achieved on E50 to E62 on map switch 1 or on any blend on map switch 2 (for 100 
octane) and 3 (for 104 octane). Above E62, map switch 2 and 3 should not be used and 
map switch 1 will give the safest and best performance regardless of what fuel the 
ethanol is blended with. 

●​ Addition of stage 3 and 4 alpha as open to view/edit examples. Description move to 
Guide to stages. 

 
CUSTOM TUNES: 
DAZA custom tunes need a checksum copied to use with the new update. This is because 
the ECU code has been changed extensively to provide new features. This can be done using 
the new “Cal checksum (EXPERT)” item in the Flex Fuel/Map switching folder of the new xdf, 
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also mentioned above. Please ensure that only checksums from matching ECU software 
version are copied. 
 
Thanks to all beta testers and especially the following for valued input, requests and ideas: 
Darin Dichiara of DoubleD tuning, Mattias Stertman of Stertman Motorsport, Kyle LeBlanc of 
Silly Rabbit Tuning, Frank Mabo of Mabotech, Vency of Madness Motorsport, Hank Iroz of Iroz 
Motorsport, Travis Logan of Better Than, Nikita Lesnikov 

25 October 2020 
1620-g954bfb39 OBD app updates for 4.0T. Go to the factory app and hit “Update & restart” in 
the Update tab. 
 
GAUGES/LOGS/DTC: 

●​ Browser/gauge log scaling for HPF increased to 32MPa. 
●​ Browser logs now have many extra items to make them more useful, 24 instead of 8 

items are sent from the ECU at 50Hz. Items include things like g forces, gear oil 
temperature, boost target, ignition timing, injector times and more. DS2 logs are still 
preferred for tuning, but the browser logs are now much more useful. 

●​ Special thanks to Travis Logan: Overhaul graph screen, new gauge screens. Gauge 
screens can be navigated with the arrows (if using a touchscreen) or with a double tap of 
CANCEL followed by UP or DOWN cruise control buttons. Please look out for updates 
on Travis’s beautiful touch screen display with special dash mounting for DAZA and 4.0T 
that will have even more options such as automatic logging to the cloud and support his 
work. 

●​ DS2 now shows a variable name after the English name that matches axes in 
TunerProRT. If using our template to view a standard set to save you selecting them, this 
will be updated very soon, otherwise just select the fields you want to display. 

●​ DS2 can now log around 400 items simultaneously at up to 200Hz. Future updates will 
use more of this power and flexibility. 

●​ You must download, unzip and use the new DS2.zip from the DS1 File tab or 
logging will not work if you use an old version. 

●​ Add VAG specific DTC short description. Thanks to Nikita Lesnikov for idea. 
●​ TunerProRT can now do realtime tuning whilst the browser gauges and logs work. As 

previously, DS2 will stop the browser gauges and logs. 
 
CUSTOM INPUTS: 

●​ 32 channels of EGT, ADC or switch inputs can now be logged in DS2. The CAN inputs 
must be attached to powertrain CAN. This has been tested by sending CAN frames with 
Kvaser CAN but designed to be as generic as possible to accept other tools below: 

●​ CAN ID 0x780-787: eg https://www.ecumaster.com/products/egt-to-can/, 8 frames, 4 * 16 
bit items little endian = channel 0 to 31 
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●​ CAN ID 0x740-747: eg https://www.ecumaster.com/products/can-switch-board/ (with 
change from 640 to 740 or 744 CAN base ID in their lightweight CAN config software 
using eg Kvaser/Peak/ECU Master CAN to USB), 8 frames, 4 * 16 bit items big endian = 
channel 0 to 31, overlaid as alternative to 780 to 787 

●​ Testing will soon commence with https://controls.is/shop/ecu/MPC1 
●​ Future updates will allow these to be used for control as well as logged. 

 
XDF: 

●​ 4.0T torque reserve (MRESLC) at launch now switchable - please populate in map 
switches to ensure launch control works if migrating a custom map. Thanks to Kyle 
LeBlanc for request. 

●​ TunerProRT now shows the variable names used for the axes to match DS2 logs. 
●​ Add Cal checksum to Flex Fuel/Map switching folder to allow easy update of custom 

tunes when DS1 ECU custom feature code has been updated as long as any new tables 
are populated. See tooltip in the xdf for details. You can load the map you want to 
modify, then load a freshly downloaded stock as a compare bin, then open Cal 
checksum, click copy and save: 

 
 
Custom tunes (or people using old OTS maps they want to keep using on 4.0T) need a 4 
byte checksum copied from 0x80 (4.0T) to use with the new update. This is because the 
ECU code has been changed extensively to provide new features. This can now be done using 
the new “Cal checksum (EXPERT)” item in the Flex Fuel/Map switching folder of the new xdf, 
also mentioned above. Please ensure that only checksums from matching ECU software 
version are copied. 
 
1620 was released shortly after 1619 to fix an issue where DS2.exe did not show all the 
monitors. No need to flash if you already have 1619, just update and download the new 
DS2.zip, unzip it and use it. 

13 September 2020 
1615-g508a7c7e 
OBD: power save will now occur after update without needing to reflash the ECU. Gauges 
improvements thanks to Travis Logan, below menu after clicking the cog at the bottom: 
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RS3/TTRS DAZA support 8V/8S0907404A/E/G/J. 8V/S0907404K 2020 models - coming soon. 
Custom tunes (and old OTS maps from before 1 Sept 2020) do not need to be altered. 

9 September 2020 
1612-g13c73635 
OBD: Improvements to gauges. 192.168.4.1/#gauges|flip for HUD. 
192.168.4.1/#gauges|disableani for disabling animation on slow devices. 
Custom tunes (and old OTS maps from before 1 Sept 2020) do not need to be altered. 

7 September 2020 
1610-g2ef86cf6 
OBD: bug fixes to gauges. 
Custom tunes (and old OTS maps from before 1 Sept 2020) do not need to be altered. 

6 September 2020 
1609-g3a3ed394 
Update the factory app from the OBD app first. Then update the OBD app from the new factory 
app. 
Factory: performance and stability improvements for doing updates. 
OBD: gauges thanks to Travis Logan. 
Custom tunes (and old OTS maps from before 1 Sept 2020) do not need to be altered. 
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1 September 2020 
1604-ga5117f29  
Update the factory app from the OBD app first. Then update the OBD app from the new factory 
app. 
Improvements to wake up - starting the engine will also awaken a sleeping DS1. 
More filtering on ethanol signal for OBD and factory apps 
All OTS designed for stock or certified downpipes. With this update, aftermarket downpipes that 
are inefficient will cause fault codes. Emphasis changed towards enhanced ethanol use instead 
of downpipes. 
No ability in xdf to delete fault codes. 
Custom tunes (and old OTS maps) do not need to be altered. 
Please keep a copy of your xdf and all OTS maps from DS1 before updating. 

18 July 2020 
1588-g4111966a 
XDF description improvements - many thanks to Ken Bailey who improved the translations. 
 
Add stage 4 (without LP lines HPFP pistons) for A8. A8 is now at full parity with all other models 
for available staged maps. 
 
Add 4.0T stage 3X or 4X (ALPHA) (with and without LP lines HPFP pistons all models). 
Description moved to Guide to stages for clarity. 
 
Custom tunes do not need to be altered. 

10 June 2020 
1566-g5aa54e4b 
Further browser compatibility improvements. Tested with multiple browsers and platforms in 
virtualization environments - working on iOS, MacOS, Windows, Android for Chrome, Edge, 
Firefox, Safari, Samsung browser. Does not work on Internet Explorer which is outdated. 
Custom tunes do not need to be altered. 

9 June 2020 
1565-gdeaf0a97 
Compatibility improvements for some browsers. Clicking show/hide history will show when 
attempting full flash… or cal flash… which ECU the maps are being filtered by. This is expected 
to be MED17_1_1. 
Custom tunes do not need to be altered. 
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30 May 2020 
1564-g440773a2 
4G0906014B__0009, 4G0906014E__0006 , 4H0907557E__0004 only: Fix no EPC light flash 
on gauges changing or using map 9. 
Custom tunes do not need to be altered. 

23 May 2020 
1563-g15368c85 
Factory & OBD apps updated. 
Fix File and ECU display after updating where directory was empty until browser refreshed. 
Fix missing version info in browser when Update tab first clicked. 
Check if new firmware available. 
Add display of last flashed file in ECU tab. 
Allow filenames with &. 
Add VAG decimal & hex ECU fault codes which lists more related to EPC and other faults. 
When DS1 busy, prevent RealDash connect/disconnect from sending CAN frames to ECU. 
No changes needed for custom tunes. 

20 May 2020 
1562-gb333c713 
Add TCP server on port 9996 for RealDash. 
No changes needed for custom tunes. 

19 May 2020 
1561-g953e3011 
All versions: ignore variant coding for Power Class (facelifts only), Exh Variant 5 and Fuel 
Quality 1 and force them all to zero which is by far the most common worldwide variant. This 
mainly affects Central America/Caribbean vehicles, but the fix ensures that the switched, 
blended and displayed maps are all correct in OTS and custom tunes based on the xdf and 
avoids the need to change up to 96 ignitions maps. 
Comms setting in factory app to handle ECUs that do not respond to generic OBD (mainly 
Central America/Caribbean). 
Factory app moves settings to new tab. 
Fix another flash counter with 100 limit that is occasionally triggered with a failed flash. 
DS2.exe adds headless option via new .bat file for logging without live graphing for convenience 
or low power laptops. 
DS1 sleep poll of ECU no longer used if any CAN activity is detected on the OBD side of the 
gateway to aim for greater cooperation with other OBD devices. 
Add stock rev limit options for RS6/7/S8 for stage 1 and stage 1 COD for use without TCU flash 
(all other OTS have default 7000 RPM limiters). 
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Add stage 4 with LP lines and HPFP pistons for A8. 
Custom tunes will require 4 byte checksum to be copied at 0x80 from stock or an OTS map. 

11 May 2020 
1560-g22314764 
Fix critical error in A8 4H0906014J (one user affected). For everyone else this update is non 
critical: 
 
Flex fuel: Based on suggestion from John McDonald of Silly Rabbit Tuning to separate blending 
of injector scaling from lambda target for flexibility on high boost high ethanol engines. 
Implementation involves changing injector scaling to use the ethanol content raw instead of 
blend fuel. Blend fuel was always kept linear anyway, but it can now be non linear to chiefly alter 
lambda targets without upsetting the injector scaling. The list below shows tables marked as 
“lineth” which use raw ethanol content, and those marked “fuel” use blend fuel. Previously they 
all used blend fuel. 
 

 
OTS: change max overboost before throttle closure to 300hPa instead of 130 to 200hPa default. 
This avoids throttle closures and allows the boost control adaptation to learn and improve. 
 
Stock flash: When used as recovery mode it recovers better from interrupted flashes. 
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Custom tunes: require a 4 byte checksum to be copied from a fresh stock or OTS map 
downloaded from the DS1 after an update. 

28 April 2020 
1558-g14dd94cb 
OTS: 
Reduce timing on S6/7 Stage 3 & 4 91 octane by 0.75 to 1.5 degrees. 
Reduce load in response to knock 
XDF: 
Add more cold start tables 
CUSTOM TUNES UNAFFECTED 

20 April 2020 
1557-g53444270 
Minor OTS updates only - for 99% of users these are tiny changes to smooth the midrange 
boost control to avoid oscillations 
Reduced PD boost control gains 
Increased allowable overboost to 0.3 bar before closing throttles 
A8 fix to maximum LPFP duty relevant to stage 3 users on ethanol 
RS6/7 4G0906560___0013 (only 2 users of this, 0 in N America), S8 4H0907557G__0005 (0 
users yet), A8 4H0906014G__0009 (0 users yet) new code to make switchable maps and 
blending work on KFDPTAVE, KFKSTTMHDR, KFRLXSTRN, KFNTBKS. 

16 April 2020 
1555-gb25a5d4b 
END OF BETA - PLEASE UPDATE FACTORY APP FROM OBD APP FIRST. 
THEN UPDATE OBD APP FROM FACTORY APP. 
FACTORY APP: 
Updated certificates for March 2021 onwards server access. 
Ability to upload settings file as directed by support. 
OBD APP: 
Updated certificates for March 2021 onwards server access. 
OTS: 
Dwell time increase 
Reduced ignition retard at high air temperatures especially on S6/S7/A8 
Extra ignition timing on high octane fuels/ethanol on S6/S7/A8 
Increase low fuel pressure target 
7000 ECU RPM limiter and display on all models (TCU determines upshift points) 
Removal of stage 2W that wasn’t needed with some changes to stage 2. 
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Lots of new custom features for custom/user tuning. Please support the great custom tuners on 
this platform who operate locally or worldwide. Special recent thanks for feedback/testing to 
Vency at Madness Motorsport, Mirza at Boosted Euro, Kyle at Silly Rabbit Tuning, AMS, Roman 
Katsev. All our dealers are listed on our website and more are being added. 
 
XDF: 
Extra tables and improvements, particularly direct WGDC is now shown with correctly scaled 
axes and contents in map switches 
 
Access DS2 and TunerProRT through LAN: 

 
Tools… Preferences then click Configure Plug-in Component under DS1 MED17.1.1 Audi 4.0T: 

 
There you have the option to change the IP address. After changing the IP address, click 
“Initialize Emulation Hardware”. This change is only used during this session. This can be used 
if the WiFi is very near or in the car and stable. When custom/realtime tuning please ensure all 
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precautions to ensure that the tuner and vehicle operator know the state of the vehicle at all 
times. It is up to users to device VPN or remote desktop arrangements to suit their workflow. 
 
DS2.exe can be run from the command line (or you can make a clickable .bat file like the 
examples in DS2.zip) with the option --ip=192.168.1.177 for example to also use another IP 
address. The frequency of data is high with DS2 and it is even more important to have a good 
quality WiFi link. 

 
 
Please download and unpack/use the DS2.zip and the TunerPro dll (in the TunerPro plugins 
folder) to get these new features. 

 
 
Water/methanol injection safety in custom mapping: 
Flex fuel/map switch enable now has the following new options of 2 and 3, 2 is recommended 
for safety. This has been initially tested with Aquamist, where a voltage output signifies that the 
system is happy. 
1=enable. 0=flex fuel/map switch tables are ignored and the original tables are used. 2=enable 
and force map 0 if rear lambda sensor 1 under 1V. 3=enable and force map 0 if rear lambda 
sensor 1 over 1V. 
If a check engine light is configured to illuminate due to missing ethanol content, map 0 will also 
now be forced. CAN ethanol error timer info now reads, “Max time (ms) for ethanol blend 
calculations without new ethanol content being received from CAN before MIL and forced switch 
to map 0. 0 to disable - required even if Flex fuel/map switch enable (K_FF) is 0.” 
 
Previous custom maps may need a checksum copied from the 4 bytes at 0x80 from a new 
stock or OTS map 
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3 April 2020 
1552-gc8ba6c81 
Xdf adds “Knock prevention” folder which involves ignition retard based on estimated 
temperature at the intake valves which is probably a bit heavy handed on S6 running ethanol. 
Custom tunes do not need to be updated. 
No OTS are changed. 

28 March 2020 
Version 1549-g0da3c045 will likely be the penultimate or final version of the beta test. 
Please read the notes carefully: 
 
Ethanol: 
Changes for better combustion on high E mixes: start of injection, fuel pressures, lambda, 
increased dwell, logging misfire counters and injection timing variables. Start of injection is now 
blended by “blend load”. 
 
All models: 
Extension of individual cylinder timing up to high loads to reduce average knock. 
Prevention of excessive modeled EGT enrichment 
 
RS6/RS7/S8 ONLY: 
Stage 1: Reduce ignition timing by 0.75 degrees on 93 octane to increase average timing after 
knock control and reduce the chance of needing to drop to map 0 with 93 octane. 
Stage 2: More achievable boost targets. 
Stage 1 and 2 support stock or aftermarket intakes. 
Stage 2W: stage 2 + extra WGDC if not reaching target boost on some intakes. 
 
Facelifts: 
Removal of WGDC killing nannies which improves boost near 100% WGDC. These are not 
present on the pre-facelifts. 
 
Direct WGDC control (stage 3 on RS6/RS7/S8 or stage 4 on S6/7): 
Now has atmospheric pressure compensation to 1013.25hPa standard pressure target x axis 
(credit to prj for suggestion) 
 
Browser: 
Change ethanol content manual set and map switches to text entry instead of sliders 
Addition of browser logger (experimental). 
 
xdf: 
Addition of exhaust flap and injection timing folders, and other additions to facilitate OTS map 
improvements. 
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DS2 logs: 
Time clock is now millisecond accurate so can be used for performance testing. 
Logging cam timing targets and actuals. 
Logging cam adaptation (credit John McDonald Silly Rabbit Tuning). 
Warning: 
Upgraded turbos on S6/S7 come with a specific warning: expect to have to replace the clutches 
even if you have a TCU flash. 
 
Upgrade notes: 
Previous custom maps need a checksum copied from the 4 bytes at 0x80 from a new stock or 
OTS map to the existing OTS map because all versions have new ECU code to allow some of 
the above improvements. They also require SOI tables to be populated for all used map 
switches since these will be 240 degrees by default as this is a 0 byte. This is very 
important and could be missed accidentally so a safety check has been added to the 
code that ignores the map switch/blend for SOI if the gasoline or ethanol map has a 0 
byte as its first entry (240 degrees in the top left corner). 
 
Please ensure you download, unzip and use DS2.zip and TunerProRT dll if you use it 
because they have important changes and otherwise you may get errors on logging or 
missing items in datalogs. 

2 March 2020 
1542-g50ca8f5f adds tables and datalogging for EGT based enrichment. OTS maps are 
unchanged. 

1 March 2020 
1540-g8fe98b00 brings extensive changes to the boost gauge, fuel economy display, datalogging 
enhancements focused around transmission and a new custom TCU torque strategy that can work 
with or without a TCU tune for improved control and safety. 

Custom maps need 4 byte checksum copied at 0x80 from stock or an OTS map. Also they need the 
“Fuel cons corr fac dash” gasoline and ethanol for any map switches used copied from an OTS map 
otherwise 0 values will give unpredictable fuel economy display. “Boost gauge wrap and scale” 
should be set to 192 to continue previous behaviour. No other maps need to be moved or adjusted 
unless new features are required for the boost gauge or TCU torque limits. This should take about 5 
minutes to do, but please consult your pro-tuner before updating and remember that any map saved 
on the DS1 will not be usable or even downloadable after an update, so always make sure you have 
a local copy. 

OTS: 

* Fuel economy corrected for ethanol content 

* New boost adaptation ranges for better learning. 
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* Stage 2 RS6/7/S8 and stage 3 S6/7 have a compressor PR limit of 2.9 in the midrange to avoid 
pressure targets that brush the pressure sensor limits. Most with high flow intakes did not hit them, 
but some on RS6/7 intakes did. These models also have enhanced maximum LPFP duty of 90% as 
a few vehicles were limited on fuel pressure at 75%. 

* Stage 3 RS6/7/S8 and stage 4 S6/7 use direct WG strategy for enhanced boost control. 

Datalogging: 

* 2 .bat files are in DS2.zip which log alternate parameters including some rarely used ECU items 
and some transmission related values. The main DS2.exe is still the one to use for normal logging. 

Custom map: 

* New boost gauge configurations - see xdf, include removing wrap, removing vacuum and rescaling 
without wrap. 

* TCU torque limit has new modes - except existing 0 or 1, you can also set a value from 2 to 100 
representing 20 to 1000Nm. If the TCU asks for more than this, the ECU will interpret it as 1000Nm. 
This can be used with or without a TCU flash and its purpose is to allow full torque but be ready to 
use any value less than stock torque limits of eg 550Nm and 760Nm from DSG and ZF. This has 
been tested with 700Nm on ZF to avoid jittering if the trans sends value close to 760Nm and works 
smoothly. 

 
As per the screenshot, it is important to use and unzip the new DS2.zip downloaded from the 
File tab of the OBD app after updating. 

 
Here you can see alternate logging sets. Generally use DS2.exe as before, but the two .bat files 
give new transmission related values and some rarely used ECU extra logging items. 
 
Otherwise you may see errors like: 
 

Last update: 24 September 2025 dynospectrum.com 
Copyright (2019-2025) Dyno Spectrum Ltd. Reg in Scotland SC637530 

Reg Office:272 Bath Street, Glasgow, G2 4JR, United Kingdom 
info@dynospectrum.com  

90 

mailto:info@dynospectrum.com


 

25 February 2020 
1539-gba44c4a8 is on the server for all versions. It brings 19 new datalogging monitors related 
to torque interventions and transmission protection. It changes only the datalogging, there is no 
need to flash after updating, but until you do the DS1 will not go to sleep, so if you are leaving 
the car for a few weeks in the cold you might want to unplug the DS1 if you are not flashing it. 
Those of you interested in this will be updating again no doubt. Custom tunes need no changes. 
The new monitor Bosch names, Name shown in the DS2 logs and units if there are any: 
 
EngTrqPtd_trqLead,Tq lim of lead path from monitoring,Nm 
CoETS_trqLimLead,Tq lim of lead path,Nm 
PT_trqTraPrt,Tq max for gear protection,Nm 
PT_trqTraPrtExt,Tq external (CAN) transmission protection,Nm 
PthLead_trqInrLead,Tq inner for lead path,Nm 
GlbDa_stTrqDem,Tq intervene 1 Eff mode 
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GlbDa_stTrqDem,Tq intervene 2 Trans prot 
GlbDa_stTrqDem,Tq intervene 3 Increasing trans intervene 
GlbDa_stTrqDem,Tq intervene 4 Decreasing trans intervene 
GlbDa_stTrqDem,Tq intervene 5 Gradient limitation 
GlbDa_stTrqDem,Tq intervene 6 Diff prot 
GlbDa_stTrqDem,Tq intervene 7 Traction control 
GlbDa_stTrqDem,Tq intervene 8 Drag control 
GlbDa_stTrqDem,Tq intervene 9 Longitudinal limitation 
GlbDa_stTrqDem,Tq intervene 10 Cruise control 
GlbDa_stTrqDem,Tq intervene 11 Driver demand 
GlbDa_stTrqDem,Tq intervene 12 Speed lim 
GlbDa_stTrqDem,Tq intervene 13 No demand 
Tra_trqInMax_mp,Tq lim from trans 2,Nm 
 
We added these to attempt to provide reasons in the datalogs for the multitude of torque 
interventions these ECUs can do as this has been useful on some other platforms. We noticed 
for example that with traction control on, even without wheel slip, that some vehicles will pull "Tq 
req for load" and "Load tgt from tq req" down in little sawtooth patterns in logs, but one car 
yesterday started to experience load reductions as a result. They went away when traction 
control was turned off which was an educated guess by Mitch, but hopefully the above might 
help make it a bit more solid if we find they flip on and off at relevant points. A number of the 
interventions above may not be used, or may turn out to be useful in going faster. There are 
also a few more variables related to transmission protection that may be useful in getting more 
detail on TCU signals to the ECU at high logging speeds. Some of these interventions could be 
pre-emptive and kill your power, let's see. 

 

19 February 2020 
1537-gbe34d428 for RS6/7 Performance models only. This update removes a torque limiter. Any 
custom maps for 4G0906560F__0003 and 4G0906560G__0002 need a 4 byte checksum copied 
into them from any of the latest OTS or stock maps as this update is done by ECU program code. 
ECU and vehicle variant coding are left unchanged so when you revert to stock, any performance 
model variant coding is unaltered. 

17 February 2020 
Update 1536-g147a8fca is on the server for S6/7 only for stage 3 and 4 WITHOUT LP lines and 
HPFP plungers. For ethanol content above zero (either with a flex fuel sensor or manual ethanol 
content entry), the load limit and therefore engine boost was too conservative. RS6/7/A8/S8 are 
unaffected. All other OTS maps are unaffected. 
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13 February 2020 
Version 1535-g8ae4882 is on the server and mostly brings new cam timing enhancements. It is a 
non critical update. With this update, custom tunes need no alteration. 
 
S6/S7/A8 PRE-FACELIFT MODELS STAGE 1 & 2 91 OCTANE (MAP 0) ONLY: 
 
Now uses pre facelift ignition maps as base instead of post facelift. This reduces knock retard on 91 
octane, but gives similar average ignition timing with greater safety margin. 
 
ALL MODELS: 
 
Rationalise and tidy rev limiter names/folders in xdf. 
 
Reduce excessive richness in response to ignition retard. 
 
Vency of Madness Motorsport has very kindly allowed us to include his special cam timing to help 
spool, power and torque with separate versions to suit the different cams on different engines. 
Please consider him for your custom tuning needs, he can remote tune using the DS1 anywhere in 
the world. Please check the dealer map on our website for details. 

4 February 2020 
Updates on the server yesterday version 1533-g71f4ad77. New help tab shows new maps and some 
updated advice. The update is not critical, but has some new features and improvements and is the 
first update in the public beta that has a breaking change for those with custom maps on some 
versions (see below). 

New map switches: 

4. STOCK LIKE. Will still be a bit or quite a bit over stock as the torque requests are high and the 
highest compressor limits and load limits are used, but it is still obviously less than stage 1. It is a 
convenience and not a genuine comparison to stock for performance testing, if you want this and still 
be able to datalog, flash stage 0. 

5. VALET uses 100% load limit to aim to be like normally aspirated and will make little boost and run 
part open throttles. It accelerates enough for the car to get out of trouble. 

6. MAX COOLING puts both fans to max for cooling. It is not a performance map and is stock like to 
move around race track pits/paddock for cooling or use whilst stationary. Change to your usual map 
for racing. Beware battery discharge if engine off or even at idle. 

7. NO START. If you switch to it whilst driving then engine will run stock like, but once the engine 
stops (even due to start-stop feature), when restarting it will crank but not start. If you find yourself 
with prolonged cranking due to being in this map, just press the engine start button again to stop the 
cranking, change maps and try again. Please do not test this map whilst in traffic. 

Please ensure you are certain you switch to the correct map (usually 0 or 1 for pump gas) for normal 
use. 
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If for some reason you do not want these extra map switches, you can download the map from the 
DS1, edit "Max switchable map" to 3 so you only have maps 0-3 available, save it, send it to the DS1 
in the file tab and reflash. 

All these maps have safe settings for blending with ethanol. 

Other improvements: 

Max WGDC increasing to 100% where the boost control needs it. 

Default intercooler pump duty 95%. This adds no noise, and has been used long term by modifying 
the vehicle wiring. The charge temperatures on 4.0T need every help they can get. 

Wider allowable boost deviations to allow for stock actuators not always hitting boost targets on 
higher stages. 

Small reduction in P and D boost gains at 3000 and 4000 RPM on small turbos to smooth out boost 
curve. 

A8 4.0T updated to S/RS features. 

Fix to incorrect fan 2 min duty address on a few versions (does not actually affect fan 2 on any 
existing maps, we just needed to fix it to add MAX COOLING mode). 

IMPORTANT BREAKING CHANGE FOR CUSTOM MAPS (only affecting a few users): 

Because of the fan 2 min duty fix, we have built new ECU code for some versions which requires 
existing custom maps to have a few minutes spent updating them. 

If you have a custom map and you have 4H0907557D or E, 4G0906014B or E, 4G0906560_ or A or 
B, after you update the DS1, the custom map cannot be used without copying the 4 byte checksum 
from 0x80 from a new map to the old map. Also you should use the new xdf to fix fan 2 min duty for 
gasoline and ethanol in all 9 map switches to 10%. 

Please contact your tuner or have them contact us with any questions about this, if in doubt do not 
update without discussing with your tuner first. The update is not essential for those with custom 
tunes, and fan 2 functions normally on all custom and OTS maps to date, the fix is only because we 
had to do it to add the max cooling mode in OTS. 

Always keep a copy of custom tunes on your computer, the DS1 will not let you download old 
custom maps that are incompatible after an update. 

26 January 2020 
OTS Updates 

After 3 weeks of the public beta we have performance improvements on stock turbo S6/7, and 
cooling improvements on all S/RS models. These are inspired by dragy/strip testing, but equally 
apply to nice street cars, always keeping an emphasis on smooth and safe optimal performance in 
all conditions. Some of the improvements are a result of collaboration with Madness Motorsport who 
have long experience on this platform and many records, and are also able to tune remotely using 
your DS1. 

Stage 1/2 S6/7: 
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Increase boost, particularly on 93+ octane. 

Stage 3 RS6/7/S8 and Stage 4 S6/S7: 

Increased LPFP duty on gasoline. 

Stage 3 or higher: 

Change displayed tacho red line to 6800 RPM. It is just an indication and the actual rev limit will be 
whatever the TCU sets or 7000 RPM whichever is lower. 

Limit excessive rich air:fuel ratio in higher gears after prolonged throttle. 

All S/RS models: 

Increased base intercooler pump duty and responsiveness to air temperature. 

Added intercooler pump duty logging item. 

A8 4.0T: 

We are keen to support these models further, and if you require the latest OTS features, we'll make 
a map for you. 

Notes: 

Check low and high fuel pressure carefully on all high ethanol setups or turbo upgrades. Do this after 
a single pull. Low fuel pressure dropping below 350kPa, high fuel pressure dropping below 10MPa, 
lumpiness in RPM trace or lean spikes on the lambda sensors during a pull require 
repairs/upgrades. Whilst some S6/7 stock fuel systems handle full E85 on stock turbos, others are 
tired. The same applies to RS7 turbos even with upgraded low pressure lines. Staged maps for 
+4mm turbos are working examples that work great on some cars, but others are struggling to flow 
enough fuel as ethanol content increases. 

Consider spark plug gaps and heat range for higher stages. 

Wastegate duty may reach 95% especially in lower gears on some OTS to aim to reach target boost. 
Some vehicles will not reach target boost across the entire RPM range even in higher gears, 
whereas other similar vehicles will hit and hold boost target in 2nd gear. The boost control system 
will do what it can without overdoing it on those cars that make boost easily and can automatically 
do the optimal the hardware can manage on stock actuators without needing custom tuning. If there 
are no leaks and the turbos/engine are in good condition, actuator upgrades with a custom tune may 
help if there is a large gap between target and actual boost. Do not use upgraded actuators with 
OTS maps. 

Please do not put OTS maps on cars with existing problems. The OTS maps will not fix problems 
with your car. 

Thanks once again for all your support! 
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